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LIMITED WARRANTY AND LIMITATION OF LIABILITY

Each Fluke Networks product is warranted to be free from defects in material and workmanship under
normal use and service. The warranty period for the mainframe is one year and begins on the date of
purchase. Parts, accessories, product repairs and services are warranted for 90 days, unless otherwise stated.
Ni-Cad, Ni-MH and Li-lon batteries, cables or other peripherals are all considered parts or accessories. The
warranty extends only to the original buyer or end user customer of a Fluke Networks authorized reseller,
and does not apply to any product which, in Fluke Networks’ opinion, has been misused, abused, altered,
neglected, contaminated, or damaged by accident or abnormal conditions of operation or handling. Fluke
Networks warrants that software will operate substantially in accordance with its functional specifications
for 90 days and that it has been properly recorded on non-defective media. Fluke Networks does not
warrant that software will be error free or operate without interruption.

Fluke Networks authorized resellers shall extend this warranty on new and unused products to end-user
customers only but have no authority to extend a greater or different warranty on behalf of Fluke
Networks. Warranty support is available only if product is purchased through a Fluke Networks authorized
sales outlet or Buyer has paid the applicable international price. Fluke Networks reserves the right to
invoice Buyer for importation costs of repair/replacement parts when product purchased in one country is
submitted for repair in another country.

Fluke Networks warranty obligation is limited, at Fluke Networks option, to refund of the purchase price,
free of charge repair, or replacement of a defective product which is returned to a Fluke Networks
authorized service center within the warranty period.

To obtain warranty service, contact your nearest Fluke Networks authorized service center to obtain return
authorization information, then send the product to that service center, with a description of the difficulty,
postage and insurance prepaid (FOB destination). Fluke Networks assumes no risk for damage in transit.
Following warranty repair, the product will be returned to Buyer, transportation prepaid (FOB destination).
If Fluke Networks determines that failure was caused by neglect, misuse, contamination, alteration,
accident or abnormal condition of operation or handling, or normal wear and tear of mechanical
components, Fluke Networks will provide an estimate of repair costs and obtain authorization before
commencing the work. Following repair, the product will be returned to the Buyer transportation prepaid
and the Buyer will be billed for the repair and return transportation charges (FOB Shipping point).

THIS WARRANTY IS BUYER'S SOLE AND EXCLUSIVE REMEDY AND IS IN LIEU OF ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OR MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. FLUKE NETWORKS SHALL NOT BE LIABLE FOR ANY SPECIAL,
INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSSES, INCLUDING LOSS OF DATA, ARISING
FROM ANY CAUSE OR THEORY.

Since some countries or states do not allow limitation of the term of an implied warranty, or exclusion or
limitation of incidental or consequential damages, the limitations and exclusions of this warranty may not
apply to every buyer. If any provision of this Warranty is held invalid or unenforceable by a court or other
decision-maker of competent jurisdiction, such holding will not affect the validity or enforceability of any
other provision.
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Software Notice

The AnalyzeAir™ Wi-Fi Spectrum Analyzer is powered in part by the Linux Operating System and other publicly available
software. A machine-readable copy of the corresponding source code is available for the cost of distribution. Please contact
the Fluke Networks Technical Assistance Center (1-800-283-5853) and visit the GNU web site (http://www.gnu.org) for more
information.



Table of Contents

Title Page
USING ThiS MANUAL ... 1]
INEFOAUCTION ... 3|
Contents of the Shipping Container............cooooiiiii 4 |
Cautions and AdVISOMIES...........cciiiiiiiiiiii i, 4 |
System RequUIremMeNts........ooooiiiiiiii D |
Using AnalyzeAir with Other Onboard PC Technologies....................... 6|
Concurrent 802.11 (Wi-Fi) Protocol Support..........c..ooeeeieiiiiiiiiinnn. 6 |
Contacting Fluke Networks ..., 6|
OVEIVIEW ... A
RF Visibility and Unlicensed Bands..............ccoccoiiiiiiiiiiii A
DISCOVRIY ..o, A
Performance ..o, A
TroubleshoOting..........ooiiiiiii i 8 |
SUMMATY L. 8 |
AnalyzeAir: Mitigation and Performance Enhancement ....................... 8 |
Clean Channels..........ccooiiii e, 8 |
Identifying, Locating, and Removing Interferers...............ccccovnei.. 8 |
Device Specific SOIUtioNS ..........ccoiiiiiiiii, 8 |
The AnalyzeAir SOIULION ... 9 |
Spectrum PC Card SENSOTS........ccoiiiiiiiieee e 9
AnalyzeAir SOFtWare ...........cccooiiii e 10
AnalyzeAir Online Help ... 11
AnalyzeAir Operating SCeNArios ..........cccuuvvveeiiieie e 11
Firefighting Mode ..o 11
RE EXPEI 12
Site Survey / Network Install and Initial Configuration..................... 13
Technical CONCEPTS ....vvvieeie e, 13
DULY CYCI@ e 14
DeViCe ClaSSITIErS. .. ..iiiiiiiii i 14
WIi-Fi ClasSITIEIS ... 14
Generic Device Classifiers......ooviiiiiiiiee e 15
Interferers: Classified (Named), Generic, and Unclassified ............... 16
ANAIYZEAIT SETUD ©..eeeiiee e 17
Installing and Setting Up AnalyzeAir...........cccoooiiiiiiiiiiiiiiii 18
Spectrum PC Card Sensor Installation............cccccoocociiii 19




AnalyzeAir Wi-Fi Spectrum Analyzer 3.1™

Users Manual

Attaching and Removing an External Antenna ..........cccoooeeiiiiiiiennn,
Attaching the Antenna ...
Removing an External ANtenna ...........ccoooiiiiiiiiie e,

Using the Directional Antenna .........coooiiiiiiiiee e,

Swapping or Removing the Spectrum PC Card Sensors .......................

Starting AnalyzeAir for the First Time ..o

Repairing Your Installation ..........cccooiiiiiii

AnalyzeAir and Your PC . ...
PC Resource UtIlZation .........cooiiiiiiiii e,
Spurious Signal Detection .........cooiiiiiiii
Enabling Your PC’s 802.11 Receive Operability (But Not Transmit)...

Upgrading the AnalyzeAir SOftware ............ccoocviiiiiiiiiiiiiecee

ANAlYZEAIT— AN OVEIVIEW ...t

StatUS Bar oo

ACHIVE DOVICE TrOE .. it

Console Tabs and Operational Features...........ccccvvviiiieiiiiiiiiiieee

CoNtrol Panel .. ..o

Hiding / Displaying the Active Devices Tree and Control Panel.............
CloSE BUTEON ...eiii e
AUTO HITE oo
TeMPOrary RESTONE ... .
Permanent Restore.........oooiiiiiii

MENU OPTIONS. ..o
FIle MENU. ..o
VIBW IMBINU ..o
SPECIrUM MENU ..o
TOOIS IMIBNU . ..
Help Information...........cccoiiiii

Recording and Playback ...

INSTANT REPIAY ..o

What If I'm Not Seeing Any Data?.........oooiiiiiiiiiiiiiie e
Spectrum PC Card Sensor Not Inserted Correctly............ccooeieenne.
Faulty Configuration Settings ..........ccccooiiiiiiiiiiiee e
Erroneous Scale Settings ......co.vviiiiiiiiii
Wrong Antenna Settings.......oooiiiiiiiiiiei e
Miscellaneous DeVICe ISSUES .........ccouviiiiiiiiiii e

ACHIVE DBVICES ...t

Current Devices vs. Historical DeviCes ............coovoiiiiiiiiiiiiiiieeeeeeen

Keeping Your Eye on a Particular Device ..........cccoovviiiiiiiiiiii,

Problem Indicators and Security Alerts.........coooviiiiiiiiiiiiiiicee

Active Devices and Devices VIEW ..........coiiiiiiiiiiiieiie e,
EXPOrtiNg Data......oveeeiiiiiiie e
Working with Spectrum Tabs, Spectrum Plots, and Charts .....................

Creating a Spectrum Plot or Chart .........ccccciiiiiiiiii e

MURIPIE PIOTS ...

Measurement INTerval ..........ccooiiiiiii e

Pause and Resume PIOtS..........ooiiiiiiiiiic e,

Copying Plots and ChartS..........oooiiiiiiii e

Cutting Plots and Charts ......c..oviiii e

Pasting Plots and Charts from the Clipboard .............ccccooiiiiiiiiin,

Removing Plots and Charts ..........cccciiiiiiiie e,

Moving Plots and Charts ..o,

Selecting Multiple Plots and Charts ..........ccccooiiiiiiiiie

Z00MING IN OF OUL ..ot
Zooming In or Out on a Single Plot or Chart..........ccccccoiviiiiii.

i

20

21

21

23

23

23

26

28

28

28

28

29

30

30

31

31

32

33

33

33

34

34

35

35

35

36

37

38

38

40

41

41

41

41

42

42

42

43

44

44

45

46

46

46

47

47

47

47

48

48

49

49

50

50

50




Contents (continued)

Zooming In or Out on Multiple PlOtS ..........coooiiiiiiii
Setting Plot and Chart Parameters.........coociiiiiiiiiie e
Saving and Restoring Spectrum View Layouts..............cccoovvvvivveiiinennnn
Deleting a Spectrum VIEW ........oooiiiiiiiiie e
EXPOrtiNg Data....ccooiii e

From a Single Plot or Chart ...,

From Multiple Plots or Charts.........cccciiiiii

Sample Export Data File ...

SPECIIUM PlIOTS... .
Using Spectrum View PIOtS........oooiiiiii e
PIot CONTENT ..o

Frequency-Based PlOtS.........oooiiiiiii

Time-Based Plot . ...

Real Time FFT PIOt . ..o

POWer VS. FreQUENCY ..o

FFT DULY CYClE oo

SWEPT SPECErOGram oo

POWEr VS, TIME ..o

Real Time FFT Plot Compared with the Power vs. Frequency Plot .....

Interpreting the Swept Spectrogram Plot.........cccooviiiiiiiiiiii

What If No Data Is ShOWING? ..o
Spectrum Plot CONTIOIS .....ooiiiiiiei e

Frequency and Bandwidth to Monitor ............cccceiiiiiii

AMPIITUAE ..o

Trace SETHINGS ..ot

IMLAIKETS .

ChaNNEIS ..

Other Plot Control Panel Settings ...........coooiiiiiiiiiiee

SPECIIUM ChartS ...
Using Spectrum View Charts.........ccccoiiiiiiiie e,
Chart CoNtENT ..o

ACTIVE DBVICES ..ttt

Devices vs. Channel . ...

DeviCes VS. TIMe ..o

Channel Utilization ..o

Channel Utilization vs. TIMe ......ooiiiiiieie e
INtErfereNCe POWET .........veiiieie e
SNR (Signal to Noise Ratio)..........ccccuvviiiiiiiiiiiiii e
Navigating to Other VIeWS ...
Chart CONTIOIS . ..o

Channel or Band Selection for Channel-Based Charts......................

Selection Options for Time-Based Charts...........cccccooeviiiiiiiiccennne,

DEVICES VIBW ..
Working With Devices VIEW...........oiiiiiiiiiii e

Adjusting the Column Display ..o

Selecting the Display TYPe ....coouiiiiiiiie e

Setting the Time RanNge ........oooiiiii e,

Sorting the Display ......cooveviiiii

Keeping Your Eye on a Particular Device ..........cccccoiiiiiiiiiiiic,

LOCAtiNg @ DVICE ..ot

Obtaining Detailed Information on a Device .............cccovvveeeeciinccnn.
Miscellaneous DEVICE ISSUBS .......o.ueiiiiiiiiiie et

Signal Bounce and Fading ..........oooiiiiiiii

Near/Far Effect ...,

Device Detection TIMe .......eiiiiiiiiie e

51
51
52
53
53
53
54
54
55
55
55
55
55
55
56
5/
57
57
5/
60
63
63
63
04
65
66
67/
68
/2
/2
/3
/3
/3

/3

/3

/4

75

/6

/6

/7

77

/8

80

81

81

82

82

83

83

83

84

84

84

84

85




AnalyzeAir Wi-Fi Spectrum Analyzer 3.1™
Users Manual

Channel SUMMATY ...
Working with the Channel Summary ..........ccccoiiiii
Sorting the Display .......covvviiiii e
Channel Data.......eeeiiiii e
Miscellaneous Channel Summary ISSUES ...........ooeviiiiiieiiiiiieeieee,
802.11 Detection SENSITIVITY .....vvviiiieeiiii e
802.11 DEVICE TYPES ..ottt
Problem INdIiCators .......cvviiiii e
DeVICE FINAOI ...
OVEIVIEW ..ttt
Working with Device FINder ..........oooiiiiiiiie e,
Additional Device Finder Features..........ccoooiiiiiiiiiieecee e
“Divide and Conquer” Search Strategy .........ccooovvviiiiiiiiiie
Omni-directional ANteNNA ........coviiiiiii e
Directional ANTeNNa ........oiiiiiie e
Detecting Narrowband Devices ...........coooviiiiiiiiiiiiieee e,
LOCAl SETHINGS .
SENSOrS aNd ANTENNGAS. . ..oiiiiiiii it
CONSOIE SETHINGS ...eeieiee e
Band and Channel Settings .........cccviiiiiiiiii e
Regulatory Domain OPLiONS ......coviiiiiiiiiii et
IMONITOTING ettt
Al SETHINGS ..
SNMP Option SETtNGS. . .veeeiiiiiie e
[P AGAIESS ...
Trap FIREIS oo
Modifying Trap Filters Default Settings ..........ccocoiviiiiiiiii
Trap Filter Information Content...........ccccoiiiiiiiiii
St SNMP Traps oo
Capture Current DISPlay .......oooiiiiiiie e
Tips 0N IMage CapPtUre....cooiiiiiiiii e
Tips on Image File Naming ........oooiiiiiii e
AnalyzeAir and Your Network Operations.........cccccoovviiiiiiiiiiiieicee,
SITE SUIVRY ..o
The Physical Movement of the PC ...
ANalyzeAir SUNVeY Data .......c..oiiiiiiiii e
Additional Notes on Site Survey and the Spectrum Plots..................
Conducting the Site SUMVeY ..ot
Drawing CONCIUSIONS ....vviiiiiiiiii e
ANTENNA OPTIONS ..ot
NEtWOIK LAYOUT ...oeiiiiiiii e
Placing the FIrst AP ..o
Placing the SecoNd AP ...
Placing SUCCESSIVE APS ....oiiiiiii i
After-Deployment Site SUIVEY .........coooiiiiiiiiiiiiiie e,
Long-Term Trend ANalYSIS ........cooiiiiiiie e
Trend Analysis Procedure ...........ooooiiiiiiiiie e
Type of Data to RECOrd ........ooiiiiiiiiii i
Routine Network Monitoring and Troubleshooting................ccccoee.
Routine MONITOIING.......uieiiiiiii e
Monitoring Points and Monitoring Rotation .............cccccoeviie,
RF and Device MONItONNG .....vvviiiiiiiiie e
TroubleshOOtiNg.......ooiiiiiii
Problem ReSOIUTION ......vviiiii e,

v

85

85

85

86

86

86

87

87

87

87

88

89

91

91

94

97

98

98

99

100

100

102

103

105

105

105

106

106

107

108

108

108

109

109

109

110

112

112

114

114

115

115

116

117

117

118

118

118

120

120

121

123

123

124




List of Tables

Table Title Page
1. Generic Signals Recognized by AnalyzeAir .........ccccceviviiiiiiiiiiiiieeeeee, 15
2. Operational Features of AnalyZeAIr ...........oooviiiiiiiiiie e 31
3. Differences between the Real Time FFT Plot and Power vs. Frequency Plot... [58
4. Sample Time Rotation Schedule ... 121
5. GIOSSArY OF TEIMS ..., 125




AnalyzeAir Wi-Fi Spectrum Analyzer 3.1™
Users Manual

Vi



AnalyzeAir”
Wi-Fi Spectrum Analyzer

Using This Manual

This manual documents the applications and operations of the AnalyzeAir™
Wi-Fi Spectrum Analyzer, Version 3.1. This manual also describes how to
operate AnalyzeAir in order to configure operations. Finally, the manual
describes the comprehensive RF data displayed by AnalyzeAir.

This manual, along with the Quick Start Guide, provides all of the necessary
information for network engineers to install AnalyzeAir Wi-Fi Spectrum
Analyzer, Version 3.1, including information on how to install the
AnalyzeAir Spectrum PC Card on the OptiView Series Il or Series Il
Integrated Network Analyzer and on your notebook PC.

While many detailed operating instructions are found in this manual,
additional instruction is available from the AnalyzeAir Online Help system.
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Conventions Used in This Manual
Terminology

The AnalyzeAir Wi-Fi Spectrum Analyzer software runs on both a PC and on
an OptiView Series Il or Series Ill Integrated Network Analyzer. For simplicity,
this manual uses the term “PC” to refer to both a PC and the OptiView Series
Il or Series Il Integrated Network Analyzer.

Text

This manual uses following text conventions:

@)

Screen Text

Any text which is displayed as part of an AnalyzeAir display screen—
including menu options, check boxes, and column headings—is
presented in boldface type. For example:

Device Finder option
Channel list box

Keyboard Keys

Keyboard keys are shown in boldface type within angle brackets, as
in: <Shift> <Ctrl>.

Menu Selections

A directional arrow is used to indicate successive levels of menu

options. For example, to select the Device Finder option from the
View menu, the following convention is used:

Select View - Device Finder

Note that we simply indicate the option to be selected, not the
method used. You can use the mouse to click on View, and then click
on Device Finder or you can type <Alt+V>, <F>.

Note

This manual assumes that you are familiar with standard
MS Windows conventions.

Screen Buttons

On-screen buttons are shown in boldface type and enclosed in square
brackets, for example: [Add] [Cancel] [OK]
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Introduction

AnalyzeAir™ Wi-Fi Spectrum Analyzer (hereafter referred to as AnalyzeAir)
monitors the RF spectrum used by a variety of wireless network and
communications technologies. AnalyzeAir consists of hardware-based
Spectrum Sensors and a GUI-based application. Together, these provide
complete visibility of the RF environment in which wireless network
technologies operate.

Other monitoring technologies typically focus on protocol-oriented network
data, which only provides a picture of RF devices that are part of the
network or, in some cases, rogue devices that are attempting to penetrate
network security or jam the network. AnalyzeAir, however, is designed to
monitor and report on the underlying physical-layer RF activity, which is
shared by numerous devices that do not share the network protocols. (See
“Performance” on page 7 for a brief list of interfering devices.)

AnalyzeAir can identify nearly all sources of RF activity in the unlicensed
bands that wireless networks share with other devices, such as cordless
phones and headsets, Bluetooth devices, and microwave ovens. Based on
this data, network engineers can take proactive steps to increase network
performance and security in the face of interferers, network congestion, and
security attacks.

AnalyzeAir is intended to be installed on an OptiView Series Il or Series lll
Integrated Network Analyzer or on a laptop computer. The product employs
a single Spectrum PC Card Sensor which is easily installed on an OptiView
Series Il or Series Il Integrated Network Analyzer or on a computer. This
portable version is designed for localized, flexible support of network
deployment, monitoring, and troubleshooting.

AnalyzeAir monitors the 2.4 GHz and 5 GHz bands used by 802.11 networks
in the Americas, Australia, the Asia/Pacific region, Japan, and Europe. A
detailed, default channelization scheme is provided for each supported
band. In addition, you can define your own channelization scheme.
Channelization is discussed under “Local Settings” on page 98.



AnalyzerAir™
Users Manual

Contents of the Shipping Container

The following items are shipped with your AnalyzeAir Wi-Fi Spectrum
Analyzer:

e One Spectrum PC Card Sensor

e One AnalyzeAir software CD containing the AnalyzeAir application
and this AnalyzeAir Wi-Fi Spectrum Analyzer Users Manual

e One2.4to 2.5 GHz and 4.9 to 5.9 GHz directional antenna and one
2.4to 2.5, 4.9 to 5.875 GHz omni-directional antenna

¢ One mounting base for the directional and omni-directional antenna
e Quick-Start Guide

/A Caution

The external antenna attachment is a potentially sensitive
component, which is easily damaged. In particular, care must
be taken when removing (disconnecting) the external antenna.

Cautions and Advisories

AnalyzeAir is designed as a safe, reliable, user-friendly tool for advanced
spectrum monitoring. There are, however, a handful of actions which can
inadvertently cause difficulties with using the AnalyzeAir technology. There
are also environmental factors, beyond your control, which can cause
unexpected behaviors. We call your attention to them here so you can be
aware of these issues. Read the appropriate sections of this User’s Manual in
advance to make the most effective (and trouble-free) use of the
technology.

¢ Installing on a PC - Be sure to install the AnalyzeAir software on your
PC before inserting the Spectrum PC Card Sensor into your PC's
PCMCIA slot. See “AnalyzeAir Setup” on page 17 for more
information.

e Disconnecting the External Antenna from the Spectrum PC Card
Sensor — You can achieve increased reception sensitivity for RF signals
by attaching an external antenna to the Sensor. However, the
connector on the Sensor is relatively fragile. Therefore, care must be
taken when disconnecting the antenna to avoid physical damage
both to the Sensor and the antenna. See “Removing an External
Antenna” on page 21.
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Using 802.11 Broadcast Technology with AnalyzeAir — AnalyzeAir is
designed specifically to monitor the RF spectrum in the bands used by
802.11 technology, which is the broadcast technology used for
wireless computer networks. The technology will not function
correctly if the PC in which you have installed AnalyzeAir and inserted
the Spectrum PC Card Sensor is also broadcasting its own signals in
the Wi-Fi bands.

This means, in practice, that your AnalyzeAir PC cannot itself be part
of a Wi-Fi network; that is, the PC cannot be connected to a Wi-Fi AP
or Ad Hoc network, while you are running AnalyzeAir. There are also
limitations on using certain other network monitoring technologies
on the same PC which hosts AnalyzeAir. (Note that if the Spectrum
PC Card Sensor is installed, but you are not actually running
AnalyzeAir, the PC can participate in a network.)

See “Using AnalyzeAir with Other Onboard PC Technologies” on
page 6 for more information.

If You Are Not Seeing Any Data or Not Seeing Expected Data -
Certain peculiarities of the RF behavior can sometimes result in
AnalyzeAir not showing any data, or not showing expected data
(such as not displaying any device information for a device that you
know is out there). Failure to see data can also result from
AnalyzeAir hardware not being installed correctly. These issues—and
ways to work around them—are explained under “What If I'm Not
Seeing Any Data?” on page 41.

System Requirements

The following are the hardware requirements for installing and running
AnalyzeAir:

OptiView Series Il or Series Ill Integrated Network Analyzer
OR

Notebook computer with Pentium series processor running at 1 GHz
or faster

Windows 2000 SP4, Windows XP SP1 or SP2, or Windows Vista
operating system

512 MB RAM

30 MB of available hard disk space

Display resolution of 800 x 600 or higher (1024 x 768 recommended)
Available Cardbus slot

802.11 capability (recommended)

CD or DVD drive
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Using AnalyzeAir with Other Onboard PC Technologies

Note

If your computer has an 802.11 card, built-in capability for
802.11, or other RF transmission technology, make sure that it is
not transmitting when you use AnalyzeAir. The 802.11 capability
should be enabled (in order to detect Wi-Fi devices), but should
not be actively transmitting to, or connected with, an AP or Ad
Hoc network. See “AnalyzeAir and Your PC” on page 28 for
more information.

Concurrent 802.11 (Wi-Fi) Protocol Support

The AnalyzeAir application detects if Wi-Fi support is present in the PC,
either on the system board or as a Wi-Fi WLAN networking card. If so, and if
you are using AnalyzeAir, the software will provide basic support for the
802.11 protocol monitoring in the Devices View.

Contacting Fluke Networks

i http://www.flukenetworks.com
%4 support@flukenetworks.com
-fﬂ‘- +1-425-446-4519

Australia: 61 (2) 8850-3333 or 61(3) 9329 0244
Beijing: 86 (10) 6512-3435

Brazil: 11 3044 1277

Canada: 1-800-363-5853

Europe: +44-(0) 1923 281 300

Hong Kong: 852 2721-3228

Japan: 03-3434-0510

Korea: 82 2 539-6311

Singapore: 65 6799-5566

Taiwan: (886) 2-227-83199

USA: 1-800-283-5853

Anywhere in the world: +1-425-446-4519

Visit our website for a complete list of phone numbers.


http://www.flukenetworks.com
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Overview
This section provides an overview of AnalyzeAir.

Note

A more detailed discussion of how to put AnalyzeAir to work for
various applications—for network site survey, network planning,
daily monitoring, and network troubleshooting—may be found

under “AnalyzeAir and Your Network Operations” on page 109..

AnalyzeAir addresses several current shortcomings in radio frequency (RF)
network technology. These shortcomings exist in numerous RF domains,
such as the WLAN technology used by 802.11 computer networks. These
shortcomings fall into several interrelated categories.

RF Visibility and Unlicensed Bands

Currently, RF network system administrators lack sufficient awareness of the
RF environment in which their APs and stations (for WLANS) operate. These
“awareness” issues arise from the fact that many RF network technologies
operate in unlicensed bands. This means that multiple technologies—
technologies which are not meant to interoperate, and which represent
completely different aspects of the RF infrastructure—compete for use of
the same bandwidth.

Discovery

Current network technologies, such as those used to monitor 802.11 WLANS,
are only aware of other network elements. They have no way to discover
other nearby sources (competing technologies) emitting radio frequency
signals in the unlicensed bands.

Performance

WLANSs operate in the unregulated 2.4 GHz and 5 GHz bands, and so they
are subject to interference from other devices operating in this same
frequency spectrum: microwave ovens, cordless phones and cordless
headsets, wireless surveillance cameras, garage door openers, Bluetooth
technology, and other devices. There can also be co-channel interference
due to neighboring WLANs. These competing devices can degrade 802.11
network performance, resulting in unacceptably slow data rates and excess
packet retransmissions.
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Troubleshooting

Current WLAN technologies are aware of network devices so they can
determine if there is excess load on the network from network stations.
However, current technologies cannot see the whole RF spectrum in the
unlicensed band; therefore, they cannot identify sources of RF activity which
can cause dropped network connections and other problems.

Summary

Current 802.11 (Wi-Fi) technologies only offer protocol-level awareness. They
do not offer physical layer (RF) awareness. Lacking full RF spectrum
awareness, existing WLANs cannot apply appropriate, adaptive responses to
improve performance in the face of interferers and competing networks.

AnalyzeAir: Mitigation and Performance Enhancement

Fluke Networks’ AnalyzeAir includes sophisticated technology to detect and
classify sources of RF activity. Using this data, network engineers can take a
variety of actions to enhance Wi-Fi WLAN performance and reliability.

Clean Channels

If a certain part of the frequency spectrum is in constant use by other
devices, the network engineer can program the network to not transmit
over those channels. Conversely, by deliberately searching for “clean”
channels, the network devices can be set to broadcast over those channels.

Identifying, Locating, and Removing Interferers

AnalyzeAir can identify the types of devices which are introducing RF
interference. An interferer is any non-network RF device which broadcasts
in the same frequency bands as network devices, and which can cause
disruption to your network. For example, in the 802.11 domain, typical
interferers include microwave ovens, cordless headphones and headsets,
802.11 FH devices, and Bluetooth devices. The network engineer is alerted
to the presence of these devices and can take steps to address the problem
(including relocating or shutting off such devices).

With AnalyzeAir, the network engineer can not only identify interferers, but
can also use Device Finder mode, which makes the AnalyzeAir-enabled
computer into a lightweight homing device to track down the precise
location of the signal source. (See “Device Finder” on page 87.)

Device Specific Solutions

By knowing the ID of specific interfering devices, custom solutions can also
be tailored to specific technologies, and even specific brands of specific
technologies.
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The AnalyzeAir Solution

AnalyzeAir is a combined hardware and software technology. AnalyzeAir
makes the 802.11 WLAN “spectrum savvy”, ensuring greatly increased

reliability and performance. AnalyzeAir, the focus of this document, consists
of two primary components:

e Spectrum PC Card Sensor - Fluke Networks' Spectrum PC Card
Sensors provide the hardware foundations for AnalyzeAir. Each
Sensor incorporates a powerful spectrum-analyzer-on-a-chip,

providing full visibility for the RF spectrum in the unlicensed bands
where Wi-Fi WLANs operate.

¢ AnalyzeAir Software - The software analyzes data from the

Spectrum PC Card and provides a GUI-based view of network and RF
activity.

With AnalyzeAir, the Spectrum PC Card Sensor and software are integrated
into one convenient platform. In the figure below, an engineer uses Device
Finder mode to observe how the signal strength from an interferer varies as

he moves about the enterprise. This makes it possible to quickly pinpoint the
location of the interfering device.
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AnalyzeAir in Action

Spectrum PC Card Sensors

As a first step in the spectrum analysis process, the ambient RF environment
must be scanned and analyzed to determine the sources of RF activity in the
neighborhood of the network, especially causes of interference or other
problems.

eib02f.omp

Spectrum PC Card Sensor
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AnalyzeAir Software

The AnalyzeAir software runs under Windows XP SP1 and SP2, Windows
2000 SP4, and Windows Vista.

AnalyzeAir provides the interface—the GUI—which connects the network
engineer with the resources available from the Spectrum PC Card Sensor:

Spectrum Views — Provides plots and charts that offer a direct view into
the RF spectrum, including measurements of RF power and network
device activity.

The plots are especially useful to trained RF engineers while the charts
are informative for the expert RF engineer and the generalist network
engineer, alike. See “Spectrum Plots” on page 55 and “Spectrum Charts”
on page 72.

erb46s.tif

AnalyzeAir Spectrum Views

Active Devices — Displays all currently active Devices in the network
neighborhood, including both network devices and interferers. See
“Active Devices” on page 42.

Devices — Provides detailed information on both current and historical
device activity.

Channel Summary - Provides a statistical overview of RF activity (such as
power levels and number of interferers present) on a per-channel basis.
This view gives you an instant picture of which channels are subject to
excess interference, and which channels have the best potential for
trouble-free network activity. See “Channel Summary” on page 85”.

Device Finder — In Device Finder mode, AnalyzeAir is a convenient, user-
friendly RF “sniffer”, optimized for displaying RF power data in a way
that quickly enables the network engineer to track down interfering
devices. See “Device Finder” on page 87.

Tools — Supports configuration of AnalyzeAir. See “Local Settings” on
page 98.
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AnalyzeAir Online Help

Detailed reference information is found in the AnalyzeAir Online Help
system, which can be accessed by pressing <F1> or selecting Help > Help
Topics.

AnalyzeAir Operating Scenarios

AnalyzeAir can be used in several different ways, as described here in
summary form.

Note

Detailed instructions on putting AnalyzeAir to use for real-world
applications are presented under “AnalyzeAir and Your Network
Operations” on page 109.

Firefighting Mode
Critical Tasks:

e Identify problems in the RF environment
e Diagnose the problem as quickly as possible
e Resolve the problem
Centerpiece Applications:
e Spectrum Charts
e Devices View
e Device Finder
e Channel Summary

Typically, the IT Administrator will have AnalyzeAir up and running, with the
Channel Summary or one or more Spectrum Plots and Spectrum Charts in
view. Spectrum Charts, in particular, are an important resource for
detecting problems that may stress the network.

¢ The Devices Vs. Channel chart can indicate when one or more
channels are becoming overloaded with devices.

e The Channel Utilization chart can indicate when one or more
channels have an overall excess of RF activity, which may be due
either to device overload, or interferers, or both.

After a problem occurs, the Administrator goes into action to determine the
cause of the problem. Through a combination of the Devices View, Channel
Summary, and the Device Finder, administrators can pinpoint and isolate
the source of the problem. If the solution is not obvious (for example,
remove an interfering device), they can turn to an RF expert to help him
arrive at a solution. (An RF expert can take further advantage of the more
detailed information in the Spectrum Plots.) The key point is that
administrators need to be notified before the problem has progressed too
far so that they can take proactive measures. This eliminates frustrated calls
from management.

11
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For example, in the Channel Summary administrators may notice two
interfering devices causing interference on channel 6. They may further
observe a heavy Duty Cycle on channel 6, as seen on the Channel Utilization
plot. They can then use the Device Finder to locate the interfering devices,
and then shut them off, relocate them, or shield them.

RF Expert

12

RF experts are individuals with an advanced knowledge of radio frequency
technology, and its associated physics and electronics. They are conversant
with the use of spectrum analyzers, as well as the inner workings of wireless
network systems. Such individuals are most likely to be at work at
installations where the wireless system is considered mission critical.

The RF Expert uses AnalyzeAir as a 24 hour-per-day, 7-day-per-week
spectrum analysis tool.

Critical Tasks:

e Investigate reported spectrum events at the raw RF level.

e Review raw RF data for cases that are unclassified by AnalyzeAir

e Confirm that recommended solutions have alleviated the problem
Centerpiece Application: Spectrum Plots

RF Experts primarily use the detailed plotting capabilities of Spectrum Plots.
When they are called in on a problem, they use the Spectrum Plots to
confirm and/or supplement the intelligence capabilities built into
AnalyzeAir. For example, if AnalyzeAir reports that a video interference
signal is occurring, the RF expert may wish to view the Power Vs. Frequency
and Real Time FFT plots to confirm that it is not some other type of device.
In addition, there will always be cases where AnalyzeAir does not recognize
the type of interference at work. In that case, the human intelligence of the
RF expert helps fill in the missing gaps.

AnalyzeAir can also be used to confirm when a problem has been fixed by
corrective action. When a fix has been attempted, the IT department can’t
afford to wait until the next day to see that no problems re-surface. The RF
expert can use AnalyzeAir functions to perform before-and-after
comparisons that confirm that a fix (for example, shielding was placed
around an interference device) has indeed fixed the problem. These
comparisons are enabled by the record/playback capabilities. (See Recording
and Playback” on page 38.)
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Site Survey / Network Install and Initial Configuration

AnalyzeAir is an invaluable tool for supporting pre-installation of Wi-Fi site
surveys and for doing an initial installation and configuration of a WLAN
system.

Critical Tasks:

e Set channel usage for Wi-Fi APs

e Deploy Wi-Fi APs for effective coverage

e Pre-emptive interference mitigation
Centerpiece Applications:

e Spectrum Plots and Charts

e Device Finder

e Channel Summary

e Devices View

AnalyzeAir can be used prior to deployment of a Wi-Fi WLAN network, to
obtain information which is essential for planning optimum deployment.

e Band and Channel Allocations: AnalyzeAir can determine which
bands and/or channels have the most RF activity. Wi-Fi APs can then
be programmed to use other channels, resulting in higher speed
transmissions, and reduced packet retransmissions.

¢ Pre-emptive Interference Mitigation: Any interferers which are
discovered to be contributing significant RF activity can be moved, de-
activated, or shielded, before putting the WLAN system into
operation.

e AP Placement: As a lightweight, mobile RF probe, AnalyzeAir can
determine which general areas have the highest level of RF activity—
as determined by the Devices View, the Device Finder, and the
Spectrum Plots and Charts—and therefore require the most APs for
adequate network coverage.

Technical Concepts

AnalyzeAir is designed to make the RF spectrum accessible even to non-
experts—people who are not RF engineers or physicists—by performing a
tremendous amount of high-level analysis on behalf of the user. For
example, AnalyzeAir can classify interfering devices, sparing the user the
necessity interpreting a spectrum graph to determine which kinds of
interfering devices are present.

At the same time, AnalyzeAir does make a wealth of technical information
available to the user, and some familiarity with RF concepts is helpful.
Neither this guide nor the online Help system attempts to present a detailed
discussion of radio frequency theory, but a few concepts are worth some
brief clarification.

13
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Duty Cycle

Among the various measures of RF power, AnalyzeAir includes the ability to
measure and report on the RF duty cycle. Duty cycle is a general term which
relates to how much RF energy is present in the spectrum, as measured not
by raw RF power (that is, not in watts or dBm); but rather in terms which
indicate how much RF power is present in some operational or functional
sense. The goal is to have a measure of RF power which suggests how much
impact the RF power will have on network performance. AnalyzeAir uses
two different measures of duty cycle:

e The percentage of the time that the RF signal is 20 dB above the
noise floor.

e The percentage of the time a transmission from a known device is
present in the channel or band.

Throughout this manual we indicate which measure of RF power is used by
various AnalyzeAir Console display modes. The Online Help also has a topic
(Duty Cycle, in the Background Information folder) which compares the
usage of duty cycle in various contexts in the AnalyzeAir application.

Device Classifiers

You, as the user, make the vital distinction between network devices and
interferers. In addition, AnalyzeAir supports this distinction, in terms of how
data is structured and classified on the AnalyzeAir display. However, the
underlying technology used to detect and classify both network devices and
interferers is the same. Fluke Networks has developed advanced classifier
algorithms, which run on the processor on your laptop PC. These classifier
algorithms use the spectrum data from the Spectrum PC Card Sensor to
categorize devices which are part of your network, or which can interfere
with your network.

Wi-Fi Classifiers
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The classifiers supported in AnalyzeAir are as follows:
e Wi-Fi APs (in-network, known, unknown, Ad Hocs)
e Wi-Fi Stations
e A wide variety of Bluetooth devices
e A wide variety of cordless phones
o Cordless Phone, 2.4/5.8 GHz, DECT1
o Cordless Phone, 2.4/5.8 GHz, DECT2
o Cordless Phone, 5.8 GHz, DECT3
o Cordless Phone, 2.4 GHz, TDD/Fixed Channel variant 1
e Microwave Ovens
e Generic Frequency-Hopped

e Continuous transmitters (e.g., FM phones, NTSC, etc.)
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e RF Jamming devices
e 802.11FH devices
e Analog Video

Generic Device Classifiers

AnalyzeAir supports the ability to classify “generic” devices. Generic devices
cannot be linked to a specific device type, manufacturer or transmission
protocol. They are identified by their physical layer transmission
characteristics. An example of such a device is a cordless phone that uses an
unrecognized transmission protocol to exchange data with its base station
(i.e., a phone that doesn’t use Bluetooth, 802.11FH, TDD or DECT).

The following list of generic signals recognized by AnalyzeAir is subject to
revision without notice:

Table 1. Generic Signals Recognized by AnalyzeAir

Pulse Type Analog or Modulation Output Parameters
Digital Type

Continuous Digital FSK RMS power, bandwidth,
coarse and fine CF'

Continuous Digital OFDM RMS power, bandwidth

Continuous Analog FM RMS power, bandwidth,
coarse and fine CF

Continuous Analog cw RMS power, coarse and
fine CF

Burst Digital FSK RMS power, bandwidth,

symbol rate, coarse and
fine CF, burst period

Burst Digital OFDM RMS power, bandwidth,
burst duration

'CF = center frequency

In the Active Devices list, these devices are identified by means of a
hierarchical listing which will indicate the pulse type, modulation type, and
possibly the frequency. For example:

Generic Devices [5]
Burst, Fixed Frequency [3]
Channel Group @ 2431.3 MHz [2]
Device 1 (FSK)
Device 2 (FSK)
Channel Group @ 2434.3 MHz [1]
Device 1 (FSK)
Continuous [2]
Device 4 (CW) @ 2430.1 MHz
Device 7 (FSK) @ 2440.1 MHz

The bracketed numbers indicate the number of devices.

A similar naming scheme is used in the Devices View.
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Interferers: Classified (Named), Generic, and Unclassified

AnalyzeAir classifies many different interferers — that is, devices which are
not network devices, but which produce RF power in frequency bands that
affect your network. For purposes of AnalyzeAir operations, there are three
broad categories of interfering devices.

Classified Named Interferers

For many interfering devices, AnalyzeAir can detect and classify the type of
device, in some cases to the extent that it can name the specific model of
device in question. So, for example, AnalyzeAir will not only identify an
interferer as being a Bluetooth device, it will also indicate a brand name and
model. However, for our purposes, a “named” device is one for which
AnalyzeAir can indicate the category of operation (Bluetooth, microwave
oven, cordless phone, etc.).

Classified Generic Interferers

16

These are devices for which AnalyzeAir has a great deal of technical
information about the signal from the device, such that the general nature
of the RF emitter can be identified. However, the AnalyzeAir system does
not present a name (such as DECT2 or Bluetooth) nor does it present a list of
devices (product names) that can be in this category.

For the generic devices, AnalyzeAir provides the kind of signal details
indicated in Table 1. In fact, what AnalyzeAir essentially provides are
detailed parameters about the RF signal from the device, rather than about
the device per se.

Example: In the case of Continuous Transmitter FSK, “Continuous” means
the device transmits continually rather than in bursts, and “FSK” (Frequency
Shift Keying) refers to the signal modulation. Specific devices, such as DECT2
devices, are also “continuous FSK” transmitters, but if AnalyzeAir does not
identify the interferer as DECT2, it is because other expected transmission
properties of DECT2 devices were not detected. Hence, AnalyzeAir only
provides the broader, generic classification based on the type of signal.



Wi-Fi Spectrum Analyzer
AnalyzeAir Setup

Unclassified Interferers

An “unclassified interferer” is literally one that AnalyzeAir does not classify.
That means it is not identified, as a device per se, anywhere on the screen
(such as in the Devices View or the Active Devices list). It also means the
device is not included in counts of devices. On the Channel Summary
display, the Total Channel Utilization field does not include measurements
of unclassified interferers. However, AnalyzeAir still does see RF energy from
unclassified interferers.

Notes

The Total Channel Utilization on the Channel Summary display is
an estimate of the percentage of the time that a transmission is
present in the channel or band. To be included in this estimate,
the transmission must be associated with a known, identified
device. Therefore, transmissions from unclassified interferers are
automatically excluded. In addition, it is possible that there may
be some transmissions from generic interferers that AnalyzeAir
cannot actually identify as belonging to those devices. Those
transmissions are also not included in the Total Channel
Utilization.

The plots and charts which show RF power (Real Time FFT, Power
vs. Frequency, and the Swept Spectrogram) or duty cycle (FFT
Duty Cycle, Channel Utilization, Channel Utilization vs. Time,
and Swept Spectrogram) do show all RF power / duty cycle
detected by the Spectrum PC Card Sensor, regardless of the
source. So, power / duty cycle from unclassified interferers is also
included.

Naturally, Fluke Networks tries to minimize the number of interferers that
AnalyzeAir cannot classify at all.

AnalyzeAir Setup

Notes

When installing software on an OptiView Series Il or Series Il
Integrated Network Analyzer, attach an external USB CD drive to
the instrument. If you do not have an external CD drive, refer to
the OptiView Series Il or Series Il Integrated Network Analyzer
online Help for information on how to install software from
another PC.

Be sure to install the AnalyzeAir software before installing the
Spectrum PC Card Sensor into your computer. If you have
installed the Spectrum PC Card Sensor first, see “Repairing Your
Installation” on page 26.
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Installing and Setting Up AnalyzeAir
To install and set up AnalyzeAir, do the following:

1. Insert the installation CD into your CD-ROM drive.
A Product Install Web page automatically opens in your Web
browser. If it does not, open the setup.htm file on the CD.
2. Select Install AnalyzeAir.

You may see a series of security warning screens. These warnings do
not indicate any breach of security on your PC.

3. On the Welcome screen, click [Next].

You will see a standard software license agreement.

4. Review the agreement, and if you concur, select “l accept the terms
of the license agreement.” Then click [Next].

5. Enter your User Name and Organization Name. Then, click [Next].
The next screen shows the default installation directory.

6. To choose a different location, select [Change...], and use the dialog
box to indicate a different folder. When you are satisfied with the
installation location, click [Next].

7. On the Ready To Install The Program dialog box, click [Install].

InstallShield starts to install the AnalyzeAir software.

An indicator bar is displayed to update you on the progress of the
installation.

8. On the InstallShield Wizard Completed dialog box, you can select the
Register Product check box. A Web page where you can register your
AnalyzeAir software is automatically displayed.

Note

Fluke Networks can only provide product support if you
register your software.

9. C(lick [Finish] to complete the installation.

18
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Spectrum PC Card Sensor Installation

Note

Install the AnalyzeAir software before installing the Spectrum PC
Card Sensor into your computer.

To install the Spectrum PC Card Sensor:
1. Insert the AnalyzeAir Spectrum PC Card Sensor into an open PCMCIA
slot on your computer.

The pins should go in first, and the LEDs on the card should be face
up.
2. Press the card gently but firmly into place.

You may see a screen which asks if you want Windows Update to
create a device driver.

3. Of the three available options, select [No, Not At This Time].

| Found Mew Hardware Wizard |

Welcome to the Found New
:‘\3 Hardware Wizard

Windows wil sasch o cument and updsted soltware by
locking an pou camputer, an lhe hardwere nslalishon CD, o on
the Windows Update Web sie [wilh your peimezsion),

Can 'wWirdows connect 1o ‘Windows Updsbe Lo sesrch loe
soltwars?

) Wes, this lime orly
() Wes, row and every Bme | conrect & devics

{&) Mo mot this Bme

Click Mt b corinue

Mesd » Cancel

eib18s.tif

A dialog box indicating that new hardware has been found is
displayed.
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4. Normally, leave the default option (Install the software
automatically) selected, and then click [Next].

Found New Hardware Wizard

This wizard helps you install software for:

Analyzedir Spectrum PC Card

() If your hardware came with an installation CD
&2 or floppy disk. insert it now.

‘Wihat do pou want the wizard ta da?

(%) Install the software automatically [Recommended)
() Install from a list or specific location (Advanced)

Click Next to continue.

[ <Back || Mew> | [ Cancel

eib20s.tif
Another dialog box is displayed, indicating that driver installation is
in progress.
A final dialog box is displayed when installation is complete.

5. You may select the Registration check box to bring up an online
registration page after installation is complete.

6. Click [Finish].

Attaching and Removing an External Antenna

Note

Try to minimize the number of times the external antenna is
connected and disconnected. Repeating these actions over 500
times may degrade the connector’s performance.

The Spectrum PC Card Sensor has an internal antenna; however, you can
obtain improved detection sensitivity by using an external antenna. You can
use the omni-directional antenna or the directional antenna.

A\ Caution

Care must be taken when removing (disconnecting) the external
antenna. See “Removing an External Antenna” on page 21 for
information.
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Attaching the Antenna

A\ Caution

When using AnalyzeAir on the OptiView Series Il or Series lll, be careful
when you close the bail after you attach the antenna to avoid damaging the
antenna.

To attach the antenna:

1. Mount the Velcro strip to the back of the PC. (The strip has adhesive
backing.)
Attach the plastic holder to the Velcro strip.
Slide the antenna’s support staff into the slot on the holder.

A cable extends from the bottom of the antenna support staff. The
end of the cable has a plug.

4. Install the antenna plug into the external jack on the Spectrum PC
Card Sensor.

Removing an External Antenna

/A Caution

Be careful when you when you remove (disconnect) the
external antenna. If you do not remove the plug carefully, you
can permanently damage the MMCX antenna jack on the Sensor
and the Sensor itself.

The connector for the antenna is relatively fragile and requires careful
handling to avoid damage.

Never disconnect the antenna by pulling on the antenna lead (the wire
connecting the antenna to the Spectrum PC Card). Doing so can cause
damage to the cable, connector, and the card.

/A Caution

Failure to follow the instructions can cause the antenna or
Spectrum PC Card to become inoperable, and failure to
properly disconnect the antenna may lead to voiding the
warranty.
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When you remove the external antenna, make sure you pull the plug
straight out of the jack.

Note

You may find it easier to detach the antenna if you first
remove the Spectrum PC Card Sensor from the slot. This
way, you can hold the Spectrum PC Card in one hand, while
grasping the antenna jack in the other. See “Swapping or
Removing the Spectrum PC Card Sensors” on page 23.

1. Grasp the plug—the part at the end of the antenna wire—at the end
of the antenna lead where it is mated to the Sensor card.

The best method is to pinch the connector with the thumb and
forefinger, and with the nails or the tips of the fingers, under the
shoulders of the connector.

2. Pull the connector firmly and perpendicular to the edge of the card.

You need to carefully get a grasp on the plug—we recommend you
actually use your fingernails, sliding them so as to create a gap
between the plug and the jack—and gently but firmly pull the plug in
a direction that is directly at right angles to the Spectrum PC Card.
(And perpendicular to the PC, if the Spectrum PC Card is still inserted
in the PC.) To the extent possible, you should be gripping the plug
with equal, balanced pressure from opposing sides, using two or
three fingers.

What you do not want to do is to apply any pressure to the left or
right, or up or down. We recommend you avoid a twisting motion as
well.

eib05f.omp

Attaching the External Antenna
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Using the Directional Antenna

The purpose of the directional antenna is to focus RF detection activity in a
given direction. This can be useful with all AnalyzeAir features, but is
especially useful with the Device Finder (see “Device Finder” on page 87).

The following diagram illustrates the directional sensitivity of the directional

antenna.
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Using the Directional Antenna

Swapping or Removing the Spectrum PC Card Sensors

eib06.bmp

Normally, you would not want to remove the Spectrum PC Card while the

AnalyzeAir application is running.

Starting AnalyzeAir for the First Time

After the AnalyzeAir software and the Spectrum PC Card Sensor are
installed, you can begin to use AnalyzeAir to identify sources of interference

in the neighborhood of your WLAN.

Note

Your computer should have an active 802.11 card or built-in
802.11 capability in order for AnalyzeAir to detect Wi-Fi devices.
However, make sure the 802.11 hardware is not associated with
an AP or Ad Hoc network when you use AnalyzeAir. See
“AnalyzeAir and Your PC” on page 28 for more information.
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To start AnalyzeAir:

1.

From the Start menu, select All Programs - Fluke Networks
- AnalyzeAir Wi-Fi Spectrum Analyzer > AnalyzeAir Wi-Fi
Spectrum Analyzer.

Depending on your Windows security settings, you may see a
Windows Security Alert. If you do, make sure that you select the
Unblock option.

Notes

This warning does not represent a threat to or breach of
your PC’s security.

Any firewalls, spyware guards, or other malware programs
must be set to allow AnalyzeAir to communicate via TCP/IP
and over TCP/IP Sockets. The program communicates with
the CardBus card via a TCP/IP socket, and any program that
is set to block this communication will lead to improper
operation of the program.

After the AnalyzeAir splash screen is displayed, choose the Sensor to
use. Select Internal Spectrum PC Card Antenna or External Spectrum
PC Card Antenna.

Note

As noted on the dialog box, some Sensors automatically use
the external antenna, if one is connected, and so override
any contrary setting here.

You can also select Spectrum Capture File to playback an AnalyzeAir
Spectrum Capture (.CCF) file. Click the [Browse] button to locate the
Spectrum Capture file of interest.

If you plan to use these settings in the future, check the
Automatically start sensor connection with these settings next time
application is launched box.

Click [OK].

Notes

When you start AnalyzeAir, you may see a dialog box
indicating that there is no 802.11 capability in your PC. The
program will work, but will not detect 802.11 devices.

See “Enabling Your PC’s 802.11 Receive Operability (But Not
Transmit)” on page 28 for more information.

Depending on the country in which you are located, you
may need to change the Local Settings before you can make
effective use of AnalyzeAir. In particular, you may need to
change the Band and Channel Settings.
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Select Tools > Settings....
Select the Band and Channel Settings button.

Note

For instructions on using the Settings dialog, see “Settings”
on page 100.

Settings - Sensors and Antennas
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Sensors and Antenna Settings
From this point on, you can use all the features of AnalyzeAir. You may want

to read “AnalyzeAir- An Overview"” on page 30, which provides an overview
of AnalyzeAir and its features.
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Repairing Your Installation

If you installed the AnalyzeAir Spectrum PC Card before installing the
AnalyzeAir application, the Spectrum PC Card may not be detected correctly
by AnalyzeAir.

If this happens, a message such as the following is displayed:

Hardware Update Wizard

Cannot Install this Hardware

The hardware was not installed because the wizard cannot find
the necessary software,

jr‘ Click Back if you have installation media such as a
CD-ROM. or if you know the location of the software.

[ < Back " Finish I [ Cancel
eib07s.tif
To remedy this situation:
1. Exit AnalyzeAir.
2. Remove the Spectrum PC Card. Then, reinsert the card into the
PCMCIA slot.
The Spectrum PC Card will be detected.
3. When prompted to connect to Windows Update to search for
software, select No, not this time. Then, click [Next].
!JFQI.II'IdHEw"MMMEWI'ZMd
‘Welcome to the Found New
Hardware Wizard
“Windowrs wil seseh o cumenl and updaled solbwans by
Iooking on pour compeler, on the hardware nstallsien CO, o on
Ehe Windows Update ‘Web she [with vour permezsion]
Cwl".k'n;kws conneck bowWindows Updste (o seanch lor
O e, thiss Bime orly
{3 ez, row and every tme | conrect & devics
{5 N, mot His: e
Ciick Meast bo cordirue.
M > Cancel
. eib18s.tif
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4. Select Install the software automatically. Then, click [Next].

Found New Hardware Wizard

This wizard helps you install software for

Lnalyzedic Spectrum PC Card

'\.') If your hardware came with an installation CD
&= or floppy disk. insert it now.

Wwhat do you want the wizard to do?

@ Install the software automatically [Recommended)
() Install fram a list or specific location (Advanced)

Click Mext to continue.

< Back ][ Next > ][ Cancel

eib20s.tif

The wizard begins installing the software.
5. After installation is completed, the following screen is displayed:

Found Mew Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

Analyzedir Spectrum PC Card

Click Firish to close the wizard

eib21s.tif

6. Click [Finish] to close.

You can now start AnalyzeAir.
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AnalyzeAir and Your PC

There are several important issues you need to be aware of, in terms of how
your PC interacts with AnalyzeAir. These are discussed in this section.

PC Resource Utilization

In general, AnalyzeAir is a resource-intensive application, using a relatively
large amount of CPU cycles. In particular, when you are using the Power vs.
Time spectrum plot, or the Device Finder, you can expect that any other
applications running on the PC will run slowly.

Spurious Signal Detection

Every laptop computer emits RF signals which can be detected by
AnalyzeAir. While we have implemented various algorithms to avoid
classifying these as interferers, the signals will sometimes be classified as
continuous interferers and they will always be visible in all the spectrum
plots. This issue is more prevalent when using the Spectrum PC Card Sensor’s
internal antenna.

Enabling Your PC’s 802.11 Receive Operability (But Not Transmit)

Your PC should have an 802.11 network card or built-in 802.11 capabilities,
and this hardware should be actively receiving RF signals. (Without this
capability, AnalyzeAir cannot report on the presence of Wi-Fi devices.) If
the PC lacks built-in 802.11 capabilities, you can install an 802.11 card in a
second PCMCIA slot or use a dongle Wi-Fi card.

AnalyzeAir will not operate properly if the 802.11 card is transmitting at the
same time that AnalyzeAir is making measurements. This means, in practice,
that your 802.11 card must be disabled with respect to transmitting while
AnalyzeAir is in use. At the very minimum, it should not be associated with
an AP or Ad Hoc network.

However, it is desirable for your 802.11 card to be receiving data while
AnalyzeAir is in operation at the same time. So the 802.11 technology
should be enabled for receiving data. This allows you to use software which
is designed for protocol-oriented monitoring of the 802.11 environment at
the same time that you use AnalyzeAir to observe the RF spectrum. It also
enables AnalyzeAir to provide enhanced spectrum monitoring with some
limited protocol-related data.
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Because the software associated with your 802.11 card can vary depending
on the particular hardware in use, we can’t provide step-by-step instructions.
In general, however, you need to make sure of the following:

e Your PC/802.11 hardware is enabled.
e Your PC/802.11 hardware is not associated with an AP.
e Your PC/802.11 hardware is not associated with an Ad Hoc network.

You can generally check your network associations—and change them, if
necessary—using the Network Connections settings on the Windows Control
Panel (select Start - Settings = Control Panel - Network Connections).

If your on-board 802.11 technology is enabled, but is not associated with an
AP or Ad Hoc network, it may occasionally still transmit some RF power. This
is not ideal, but is still much better than if it is broadcasting nonstop because
it is associated with an AP.

In some cases, your 802.11 hardware may specifically include software tools
that enable you to set the 802.11 device for Rx mode only, with no Tx. See
your 802.11 hardware documentation for more information.

Upgrading the AnalyzeAir Software

From time-to-time, Fluke Networks may release updates to your AnalyzeAir
software. You can install the latest version directly over the currently
installed version without having to uninstall first. Simply follow the
directions under “Installing and Setting Up AnalyzeAir” on page 18.

Note, however, that since you may not be installing from a CD, you will need
to run AnalyzeAir.exe from wherever you downloaded the installation
program on your hard drive.
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Note

If your computer has an 802.11 card or built-in 802.11 capability,
make sure it is not transmitting when you are using AnalyzeAir.
See “Enabling Your PC’s 802.11 Receive Operability (But Not

Transmit) on page 28.
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The basic features of AnalyzeAir are described in the following sections.

Status Bar

AnalyzeAir has a Status Bar at bottom, which you can toggle on and off by
using View > Status Bar.

The Status Bar displays information about the Spectrum PC Card Sensor in
use, such as the antenna in use. The Status Bar also indicates if you are in
Live mode, Playback mode, or Recording mode. (See “Recording and

Playback” on page 38 for more information.)
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Active Device Tree

The Active Devices Tree shows all APs, Ad Hoc networks, and interferer
devices currently detected by AnalyzeAir. The tree is normally on display on
the left side of the AnalyzeAir display, but can be toggled on and off by
selecting View - Device Tree. See “Active Devices” on page 42.

Console Tabs and Operational Features

AnalyzeAir has five primary operational features, four of which involve
mainly the display of data. The fifth, the Device Finder, is an active
operational mode which enables you to quickly “hunt down” interfering
devices.

These five modes of operation are accessed by selecting any of the five tabs
running across the top of the AnalyzeAir display: Spectrum, Spectrum (2),
Devices, Channel Summary, and Device Finder. The following table shows
the relationship between the tabs and their operational capabilities.

Table 2. Operational Features of AnalyzeAir

Display Tab Reference Comments
Spectrum Working with Spectrum Tabs, Each Spectrum tab can display
Spectrum Plots, and Charts — Page 46 a mixture of

Spectrum Plots — Page 55 Spectrum Plots and Charts.

Spectrum Charts — Page 72 AnalyzeAir provides two

Spectrum tabs, allowing for
Spectrum(2) two different, user-
configurable, default
configurations of Plots and
Charts.

Devices Devices View - Page 80 Detailed information on
detected devices. Unlike the
Active Devices list, this will
also show historical devices
(that is, devices that are no
longer active).

Channel Summary Channel Summary — Page 85 Summary of RF activity on all
channels.
Device Finder Device Finder — Page 87 Fluke Networks' “sniffer” for

locating unwanted RF devices.
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Control Panel

Several of the viewing modes have specific controls that enable you to fine-tune
the features of the display. For example, a Spectrum Control Panel is shown here:
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Control Panel

Usually, the Control Panel automatically comes into view when you select an
appropriate mode, such as Spectrum mode (see “Spectrum Plots” on page 55),

eib11s.omp

Devices mode (see “View"” on page 80), or Device Finder (see “Device Finder” on

page 87).

If the Control Panel is not displayed, select View > Control Panel. Select the same
menu option to toggle the Control Panel off.

In the Spectrum view, each plot and chart has its own unique controls. If the

Control Panel is displayed, but the controls for the plot/chart of interest are not

shown, click the plot or chart of interest. The appropriate controls will then be

shown on the Control Panel.
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You can adjust the relative size of the Control Panel and the Active Devices view by
placing the cursor over the line that divides them. Then, click and hold the mouse
and drag up or down.
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Hiding / Displaying the Active Devices Tree and Control Panel

You can use options on the View menu to hide or display the Active Devices
Tree and/or the Control Panel. You can also use the mouse to control the
display of the Active Devices Tree and/or the Control Panel.

Close Button

You can always close the Control Panel or Active Devices tree by clicking the
Close button.

Auto Hide

You can hide the Control Panel or Active Devices list by clicking the Auto-
Hide button, which has a small push-pin symbol on it, as shown in the

following:
! Control Panel I_Tlg
- Metric
Trkerval 4 hoirs
Chanreal | Ch 11 (2962 MHz)
Trace 1 (#3on  (JOff

Category | WWi-Fi APs

erb26s.tif
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After you do this, the Control Panel or Active Devices list is now hidden,
allowing more room for other display features (such as a larger view of the
Spectrum tab shown at right). However, a small vertical Control Panel or
Active Devices tab is still shown on the left, as shown in this figure:
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Temporary Restore

If you pause the mouse pointer over the vertical tab for Control Panel, the
Control Panel is temporarily restored to view. It remains visible only as long
as the mouse is somewhere over the tab or over the Control Panel itself. This

lets you make changes in the Control Panel or make selections on the Active
Devices tree.
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If the mouse is no longer positioned somewhere over the Control Panel or

Active Devices tree, the panel or tree disappears; only the vertical tab on the
far left remains on display

Permanent Restore

To restore the Control Panel or Active Devices tree to permanent status on
the display, click the Auto-Hide (push-pin) button:

.| i Control Panel %x
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The panel or tree now remains on display, and the small vertical tab on the
side is no longer shown.
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Menu Options
AnalyzeAir has the following menu options:

File Menu

File

View
Spectrum
Tools
Help

The File menu offers the following options:

View Menu

Open Capture File — Use this operation to play back a previously
recorded Spectrum Capture file. See “Recording and Playback” on
page 38 or more information.

Save Replay As... — Captures Instant Replay spectrum data to a
capture file for later playback. See “Recording and Playback” on page
38 or more information.

Instant Replay — This operation enables a 1- to 60-minute replay of
stored first in, first out (FIFO) capture data.

Record Capture File — Captures spectrum data to a Spectrum Capture
file for later playback. See “Recording and Playback” on page 38 or
more information.

Stop Capture File — Stops the recording of a capture and stops the
playback of the Spectrum Capture file.

Connect To Sensor — Opens a dialog box, similar to the one seen
when first logging in to the application, which enables you to select a
different Sensor, or to open a Spectrum Capture file.

Click the [Browse] button to locate the Spectrum Capture file of
interest.

Note

As noted on the dialog box, some Sensors automatically
use the external antenna, if one is connected, and so
override any contrary setting here. If you expect to use
these settings in the future, check the Automatically
start sensor connection with these settings when
software is launched box.

Exit — Closes AnalyzeAir.

The View menu provides access to most of the main AnalyzeAir features:

Spectrum - Enables you to create a variety of plots and charts which
provide real-time views of RF activity. You can save your
configuration of plots and charts. See “Spectrum Plots” on page 55.

Spectrum(2) - The same as with Spectrum; you can create a variety of
plots and charts, and save your configuration.

Devices — Shows all RF devices detected by AnalyzeAir. See "Active
Devices” on page 42.
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Channel Summary — This view shows RF activity—such as power
levels, and the presence of 802.11 and interferer devices—on a
channel-by-channel basis. See “Channel Summary” on page 85.

Device Finder — The Device Finder enables you to track down the
location of interfering devices. See “Device Finder” on page 87.

Active Devices — As already described, the Active Devices Tree shows
all APs, Ad Hoc networks, and interferer devices currently detected by
AnalyzeAir. See “Active Devices” on page 42.

Control Panel — This toggles the Control Panel on and off. The
Control Panel sets the details of your view in several different modes:
Spectrum View, Devices View, and Device Finder. (See “Control
Panel” on page 32. See also “Spectrum Plot Controls” on page 63;
“Chart Controls” on page 77; “Working with Devices View"” on page
81; and “Device Finder” on page 87.)

Status Bar — The console Status Bar provides information about the
status of the system. Use this menu option to toggle the Status Bar
display on or off.

Spectrum Menu

The Spectrum menu is only visible when the Spectrum View is active and in
the foreground (that is, when you are viewing plots and/or charts).

Add Plot — Adds one of the available plot types.
Add Chart — Adds one of the available chart type.

Remove Selected Items... - Removes the currently selected plot or
chart from the display. (You must first select a spectrum plot or chart
for this menu option to be active.)

Pause Selected Items — Freezes the display of data on the currently
selected plot or chart.

Resume Selected Items — Only shown if you first select a plot or chart
which was previously paused. Resumes the real-time update of data
for that plot or chart.

Zoom In/Out — Maximizes or minimizes the size of a selected plot or
chart.

Export Selected Items Data... — Captures and exports data from a
specified plot or chart and saves it to a file.

Cut — Deletes the currently selected plot from the display and copies it
to the clipboard.
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e Copy - Captures the currently selected plot or chart and copies it to
the current Spectrum view.

e Paste — Retrieves a plot or chart from the clipboard and copies it to
the current Spectrum view.

e Select All Items - Selects all plots and charts displayed on the
AnalyzeAir console.

e Open Spectrum View Configuration — Once you have configured plots
and charts on one of the two Spectrum tabs, you can save the
plot/chart configuration. This enables you to easily restore the same
configuration at a later time. See “Saving and Restoring Spectrum
View Layouts” on page 52 for more information.

e Save Spectrum View Configuration — See Saving and Restoring
Spectrum View Layouts” on page 52 for more information.

e New Spectrum View Configuration — See Saving and Restoring
Spectrum View Layouts” on page 52 for more information.

See “Spectrum Plots” on page 55 for information on all other spectrum
operations.

Tools Menu

The Tools menu provides access to the Settings dialog. The Settings dialog,
in turn, has four panels:

e Sensors and Antennas - Selects which Spectrum Sensor (and, in some
cases, which antenna) AnalyzeAir uses for spectrum data acquisition.

e Console Settings — Modifies the date and time presentation on
AnalyzeAir and the Spectrum View configuration to use for playback.
Enables the Instant Replay feature, selects the Default AP Category
(In-Network or Unknown), and selects the color of the plot's
background.

¢ Band and Channel Settings — Determines, by Regulatory Domain (for
example, USA and Japan), which RF bands and channels are
monitored for RF activity and reported on by AnalyzeAir. The default
setting is to monitor the channels indicated in the 802.11 b/g
selections. However, there are also options for other pre-defined
802.11 a bands including the US Public Safety Band and user-selected
channels in the middle and upper bands as well.

e Alert Settings — Enables or disables security and performance alerts
for an interferer type or category.

e SNMP Option — Configures the trap filters and threshold levels that
trigger AnalyzeAir to send an SNMP trap whenever it detects an
interfering device.

See “Local Settings” on page 98 for more information.

The Tools menu also includes the Capture Current Display command which
creates a snapshot image of the information reported within the main
window of AnalyzeAir. See “Capture Current Display” on page 108.
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Help Information
The Help menu lists the following options:

Help Topics — Provides access to the AnalyzeAir Help system.

About AnalyzeAir Wi-Fi Spectrum Analyzer... — Provides copyright
and version information for the AnalyzeAir software.

About Spectrum PC Card Sensor... — Provides technical data for the
sensor currently in use.

Capture File Properties... — Displays information (for example, time
zone, file size, and monitored bands) about the file that is being
played back.

Recording and Playback

AnalyzeAir enables you to record spectrum data in Spectrum Capture (.CCF)
files. You can then play these files back at a later time. Each Spectrum
Capture file stores the following information to disk:

Active Devices — A list of active devices vs. time, plus all information
needed to reproduce the Devices View and any of its subviews and

columns for all monitored bands during playback. (During playback
you will be able to change columns and see meaningful information
that changes with time, just as with live mode.)

Plot Data — All information needed to reproduce any of the Spectrum
Plots (except Power vs. Time and Power vs. Frequency — these plots
will not be available during playback). You can adjust the settings for
the other plots and charts during playback.

Chart Data — All information needed to reproduce any of the
spectrum charts during playback.

Reference Information — This includes the date and time of capture,
the Windows user/login name, and the Spectrum PC Card Sensor
revision and serial number.

The following diagram shows the controls used for spectrum recording and
playback.
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Spectrum Recording and Playback Controls

The controls are described here briefly. You can obtain detailed instructions
on recording and playback in the Online Help.

e Open - Opens a previously captured .CCF file for playback. You can
also select File > Open Capture File. Use the Open Capture File
dialog box to select the recording of interest

e Record - Opens a dialog box where you can define the name and file
location of a .CCF file. Upon closing the dialog box, recording begins
automatically. You can also initiate this operation by selecting File >
Record Capture File.

e Play - Starts file playback after you open or pause a .CCF file.

¢ Play Capture File Once or Repeat — After you open a .CCF file, select
this to start playback with one of the following options: play to the
end of the recording and stop or play to the end and restart the
playback.

e Stop Record/Playback — Stops the recording process. Also stops the in-
progress playback of .CCF file.

e Go Live — Returns you to live mode.
e Pause Playback - Freezes the playout.

e Jump to Previous Device Classification Event — Takes you back to the
previous event occurrence. For example, an old device went down or
a new device came up.
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e Jump to Next Classification Event — Skips ahead to the next event
occurrence. For example, an old device went down or a new device
came up.

e Slider Control — You can use this control to move to any particular
time during the playback interval.

You can select any combination of plots or charts during playback.

Just as in a live spectrum session, you can right-click within the display area
to get pop-up menus that are used to navigate to specific information.
Additionally, you can use all other plot icons and features, such as adding,
moving, zooming, and removing a plot or chart during playback.

Note

The Power Vs. Time and Power Vs. Frequency plots are not
supported during playback.

A sample spectrum capture file, called SAMPLE SPECTRUM CAPTURE.CCF, is
included with product installation. This file is located in the directory
SpectrumCaptures, which is located in the AnalyzeAir main directory. The
sample spectrum capture file includes a number of common interfering
devices, such as a DECT-like cordless phone, a Bluetooth device, an Analog
Video Camera, a microwave, and a wireless access point.

Instant Replay
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The Instant Replay feature allows you to review the most recent spectrum
information up to the past 60 minutes, without having to record it in a CCF
file, and play it back much as if it were being viewed live for the first time
without interrupting receipt of current spectrum information. Spectrum
information of interest viewed as an Instant Replay may then be saved as
Spectrum Capture (CCF) files to share information on what is happening in
the spectrum.

To display Instant Replay settings, do one of the following:
Select File > Instant Replay

OR

Select Tools > Settings > Console Settings

The controls are described briefly below.

Note

Detailed instructions on using Instant Replay settings and
initiating an Instant Replay and Converting an Instant Replay
to a .CCF file can be found in the Online Help.

¢ Enable Instant Replay of the last — when checked, enables the Instant
Replay function.

e minutes - specifies the duration of the Instant Replay (ranges from 1
to 60).
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What If I'm Not Seeing Any Data?

It may happen that you are viewing one of the AnalyzeAir displays, such as a
spectrum plot, but you are not seeing any data or data is missing for part of
a plot. (For example, some of the channels on the plot have spectrum data,

and others do not.) Or, you may know that some kind of interfering device

is present in the environment, but the Devices List and/or Device Finder are

not detecting it. This section describes possible causes of this problem.

Spectrum PC Card Sensor Not Inserted Correctly
If the Spectrum PC Card Sensor is not inserted correctly, communication

between the Sensor and the AnalyzeAir software may be impaired. Typically,

a warning message is displayed if AnalyzeAir cannot communicate with the
Sensor.

To resolve the problem, make sure that the Spectrum PC Card Sensor is
correctly seated in the slot.

Faulty Configuration Settings

You may have set your spectrum plots to display certain channels or bands,
but your configuration settings for AnalyzeAir do not include those
channels/bands.

To determine if this is the problem—and to rectify if—you need to check the
Band and Channel Settings under the AnalyzeAir Settings panel. See “Band
and Channel Settings” on page 100.

Erroneous Scale Settings

With the spectrum plots (see “Spectrum Plots” on page 55), it is possible that
you may fail to see any data if you have an amplitude setting that is
inappropriate for the actual data being monitored. For example, suppose
you are monitoring the RF duty cycle and have the amplitude set to range
from 0% to 100% (the default setting). If in fact the actual duty cycle values
are very low (say, ranging from 0% to 1% or 2%), you may not see any data.

This can be a particular problem with the Swept Spectrogram plot, where RF
power values and duty cycle values are mapped to colors. If all the
measured data falls in a very narrow range compared with the Color Scale,
you may see nothing but a solid block of a single color - in fact, you are
seeing the correct data, but it seems as if you are seeing no data at all.

Selecting the [Auto Scale] option on these plots should correct this problem,
but sometimes it helps to manually adjust the measurement scale.
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Wrong Antenna Settings

You may have a Spectrum PC Card Sensor with an external antenna, but you
are using the Sensor’s internal antenna. (This might account, for instance,
for why you might fail to see some interfering devices that you expect to
see.) You need to check your Sensors and Antennas settings. (See “Sensors
and Antennas” on page 98.)

Miscellaneous Device Issues

There are various RF effects that can prevent or partly hinder device
detection. These are discussed in detail under “Miscellaneous Device Issues”
on page 84.

Active Devices

The Active Devices Tree is usually displayed on the left side of the
AnalyzeAir screen. It shows APs, Ad Hocs, and interfering devices, provided
that these devices (APs and interferers) are currently live (transmitting). It
uses a tree structure to organize APs, Ad Hocs, and different types of
interfering devices together.

If the Device Tree is not showing, you can toggle it into view by selecting
View - Device Tree.
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If you double-click on a device, a dialog box appears providing more detail
on the device. You can also right-click on the device and select What Is This
Device?.

Right-click on any interferer device and select Find This Device to activate
the Device Finder. See “Device Finder” on page 87 for more information.

Note

The Device Finder locates only certain types of devices. If you
right-click on a device that cannot be located, the Find This
Device option is not available. Note also that a device must
currently be active (that is, transmitting) to be located. In the
Devices View, if you click on a device that is not active, the Find
This Device option is not available.
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Click Export Data to export all data in the Active Devices tree. See
“Exporting Data” on page 46 for details.

If you right-click on a wireless device in the Active Devices tree, additional
details are displayed for wireless devices:
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As shown in the previous illustration, wireless devices are categorized as
follows:

Note

By default, newly discovered APs are marked In-Network. You can
change the default designation on the Settings Console screen.
See “Console Settings” on page 99 for details.

e Unknown: potentially rogue device
e Known: neighbor AP
¢ In-Network: trusted device

These distinctions are also maintained on the Channel Summary, Alerts,
Interference Power Chart, and SNMP Traps.

Current Devices vs. Historical Devices

The Active Devices Tree only shows devices which are currently active; that
is, devices that were detected as transmitting during the last measurement
interval.

For an historical list of detected devices—which includes currently active
devices, but also devices which are no longer detected—use the Devices
View. See “Devices View"” on page 80.
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Keeping Your Eye on a Particular Device

If there is a particular device that is of interest to you, you can keep an eye
on the device simply by clicking on it. Your selected row will be highlighted.

As new devices are detected (or disappear from view), the Active Devices
tree will auto-scroll and auto-sort. However, AnalyzeAir will make sure that
your highlighted row always remains in view; in other words, auto-scrolling
and auto-sorting will be adjusted so that your highlighted row always
remains visible on the Devices tab.

Problem Indicators and Security Alerts

44

Problematic devices shown in the Active Devices pane are highlighted in
yellow or red. The colors indicate the interference level of active devices.
Yellow means that the duty cycle of the interferer is greater than 25%, and
it affects at least one channel with a BSS device. Red means that the duty
cycle of the interferer is greater than 50%, and it affects at least one channel
with a BSS device.

Security and alert settings are available and can be configured using the
Settings - Alert window. After the settings are configured, security alert
icons are displayed in the Active Devices tree when the predefined triggers
occur:
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Active Devices and Devices View

Typically, you do not need to see the Active Devices tree when you are in
Devices mode because in this mode you can see all RF devices (both currently
active and historical).

If you select the Devices tab in the main workspace and then select the push-
pin icon on the Active Devices tree, AnalyzeAir hides the Active Devices
tree. However, a small Active Devices tab remains visible on the left side of
the screen, as shown in the following figure:
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If you move the mouse over the tab, you can temporarily bring the Active
Devices tree back into view. The Devices Control Panel is temporarily hidden
behind the Active Devices pane.
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If you then click the push-pin icon (circled in the previous illustration) in the
Active Devices pane, the Active Devices pane is displayed. The Devices
Control Panel can be seen on the lower left side of the screen.

In Devices mode, you can view an extensive list consisting of active and
historical devices. To help you distinguish between currently active devices
(shown in Active Devices) and the extensive list, you may want to display the
Active Devices tree and Devices mode simultaneously. See “Hiding /
Displaying the Active Devices Tree and Control Panel” on page 33 for details.
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Exporting Data

The Export Data feature provides additional functionality to the list of active
devices in the Active Devices tree. The Export Data feature allows you to
export device information to a file for future analysis.

This option can be accessed by right-clicking on a device in the Active
Devices tree to display a pop-up menu. When Export Data is selected, a
window appears providing a default file name and Save in location
(Spectrum captures folder). The window also allows user selection of the file
name and Save in location.

Working with Spectrum Tabs, Spectrum Plots, and Charts

As indicated earlier, AnalyzeAir provides two spectrum tabs, Spectrum and
Spectrum (2). Each tab operates identically. AnalyzeAir has two tabs so that
you can create, name, and save distinct configurations of plots and charts.
You can have two of them as defaults that automatically appear on these
tabs.

Descriptions of the specific charts and plots—including the parameters for
fine-tuning the plot/chart content—can be found in the Online Help and
under “Spectrum Plots” on page 55 and “Spectrum Charts” on page 72 of
this manual. Here we provide an overview of how to use the Spectrum and
Spectrum(2) tabs to create your custom plot/chart views.

Creating a Spectrum Plot or Chart
To create a spectrum plot or chart:

1. Right-click in the workspace for the spectrum plots and select
Add Plot 2> <Plot Type> or Add Chart > <Chart Type>.

You can also use the menu Spectrum - Add Plot > <Plot Type> or
Spectrum > Add Chart - <Chart Type>.

2. Use the Control panel at the left of the display to set the parameters
for the plot or chart. The particular parameters vary depending on
the type of plot. An overview of the Plot Control panel is presented
under “Plot Content” on page 55. Detailed descriptions of chart
parameters are also contained in the AnalyzeAir Online Help system.

e [fyou are on a Spectrum tab and the Controls are not
visible, select View - Control Panel.

e To access the Control Panel for a particular plot or chart, use the
mouse to click on that plot. (If you have more than one plot in
view, then as you click on different plots, the Control Panel will
display the configuration options for the currently selected plot.)
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Multiple Plots

You can repeat the previous instructions to place more than one plot on
display. You can configure any combination of up to nine plots and charts
per Spectrum tab.

Measurement Interval

Unless you have paused a plot (see next section), AnalyzeAir updates each
plot or chart once per measurement interval, which is typically once every
second.

e Plots update once per second.
e Charts update once every 20 seconds.

Pause and Resume Plots

At times an event may occur in your network, such that you want to
immediately capture the RF environment at that moment for sustained study
and review. You can pause and resume plots and charts by right-clicking in
the workspace and selecting the appropriate menu options, or by selecting
these options from the Spectrum menu:

o Select All Items - Selects all plots/charts currently displayed on the
selected Spectrum tab.

e Pause Selected Items — Freezes the data displayed on the currently
selected plots or charts.

e Resume Selected Items — Resumes the display of data (in real time)
for the currently selected plots or charts.

You can also pause a plot by left-clicking on the Il icon, which is located in
the upper right corner of the plot. Likewise, clicking the ® icon on a paused
plot resumes the display of the data.

Copying Plots and Charts

All plots and charts displayed in Spectrum View can be copied and pasted
within the pane area of the window. You can use any of the following
methods to copy and paste a plot or chart:

e Method 1
1. Click on the top of the plot frame.
2. Press and hold the <Ctrl> key.

The cursor changes to indicate copy mode.
3. Move the mouse to the desired location.

Release the mouse button to paste a copy of the plot or chart.

The copied plot or chart is subject to total count checking and
PvT/PvF trace limit checking.
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¢ Method 2
1. Select a plot.
2. Press <Ctrl + C >.

The selected plot is copied to the clipboard.
e Method 3
1. Left-click or right-click on a plot or chart.

2. Select Copy from the Spectrum menu.

The selected plot is copied to the clipboard.

Cutting Plots and Charts
Use any of the following three methods to cut a plot or chart:

e Method 1
1. Select a plot or chart.
2. Press <Ctrl + X>.

The plot or chart is removed and copied to the clipboard.
e Method 2
1. Right-click on a plot or chart.
2. Select Cut from the pop-up menu.

The plot or chart is removed and copied to the clipboard.
e Method 3
1. Left-click on a plot or chart.
2. Select Cut from the Spectrum menu.

The plot or chart is removed from the display and copied to the
clipboard

Pasting Plots and Charts from the Clipboard

Spectrum View plots and charts can be retrieved from the clipboard and
pasted into your current Spectrum View session or into an additional
Spectrum View session running on your machine. The paste feature is subject
to total plot/chart count checking and PvT/PvF trace limit checking.

Use either of the following methods to paste a plot from the clipboard. Be
sure to cut or copy the plot or chart first (see previous instructions).

e Method 1
1. Right-click within the Spectrum View pane to display the pop-up
menu.

2. Select Paste or press <Ctrl + V>.

The plot or chart is pasted to the end of the view.
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e Method 2
1. Select one of the Spectrum views.
2. Select Paste from the Spectrum menu.

The plot or chart is pasted to the end of the view.

Removing Plots and Charts
Use the following methods to remove a plot or chart.

e Method 1
1. Right-click on the plot or chart.
2. From the pop-up menu, select Remove Selected Item....
3. On the confirmation dialog box, select [Yes].

The plot or chart is removed.
e Method 2
1. Left-click on the plot or chart.
2. Select Spectrum = Remove Selected Item...

The plot or chart is removed
e Method 3
Right-click on the X icon located in the upper right-hand corner of
the plot.

The plot or chart is removed

Moving Plots and Charts

All plots and charts displayed in Spectrum View can be moved within the
pane area of the window.

e Method 1
1. Left-click on the top banner of the plot frame.

2. Drag the plot to the desired location. A blinking vertical line
indicates the new location.

3. Release the mouse button.

The plot or chart is moved to the new location.
e Method 2
1. Right-click on the top banner of the plot frame.
2. Drag the plot to the desired location.

A blinking vertical line indicates the new location.

3. Release the mouse button to drop the plot in the new location.

A pop-up menu displays.
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4. Select one of the following options:
e Copy - pastes a duplicate of the original plot in this location.
e Move Here - relocates the original plot to this location.
e Cancel - terminates the operation.

Selecting Multiple Plots and Charts

In cases where you need to perform the same operation on more than one
plot or chart, multiple plots and charts can be selected. For example, you
may want to remove, pause, or resume more than one plot at the same time.

Note

When multiple plots and charts are selected, the control panel
displays a message indicating that no control are available for
configuring plots and charts.

Multiple plots and charts can be selected as follows:
1. Hold down the <Ctrl> key.
2. Left-click each plot to select it.

Zooming In or Out

For optimal viewing, a plot or chart can be maximized (zoom in) and
minimized (zoom out) to its original size. A plot or chart in Zoom In mode is
indicated by an orange background. Additionally, you can zoom in/out on
up to four plots or charts at the same time.

Zooming In or Out on a Single Plot or Chart
Use one of the following methods to zoom in or out on a single plot or

chart:
e Method 1
1. Click the Zoom In ® icon located in the upper right corner of the
plot to maximize the plot or chart.
2. Click the Zoom Out = icon to minimize it.
e Method 2

1. Double-click the frame of the plot or chart to maximize it.

2. Double-click the frame of the plot or chart to minimize it.
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e Method 3
1. Select a plot or chart.
2. Do one of the following:
e Select Zoom In or Zoom Out from the Spectrum menu.

OR

e Right-click on the plot or chart to display the pop-up menu.
Then, select Zoom In or Zoom Out.

Zooming In or Out on Multiple Plots

Use one of the following methods to zoom in/out on multiple (up to four)
plots or charts:

e Method 1
1. Hold down the <Ctrl> key.
2. Select the desired plots or charts.
3. While holding the <Ctrl> key, do the following:
¢ Double-click one of the plot or chart frames to zoom in.

e Double-click one of the zoomed-in plot or chart frames to
minimize them all.

e Method 2
1. Hold down the <Ctrl> key.
2. Select the desired plots or charts.

3. From the Spectrum menu, select Zoom In to maximize or Zoom
Out to minimize the plots or charts.

Setting Plot and Chart Parameters

To set plot or chart parameters once the plot/chart is created, simply click on
the plot or chart. The Plot Controls panel appears on the left side of the
screen. Refer to “Control Panel” on page 32 for additional information on
using the Plot Controls panel.
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Saving and Restoring Spectrum View Layouts

Other operations are available for working with plots and charts. The
following operations can all be selected from the Spectrum menu: Open
Spectrum View Configuration..., Save Spectrum View Configuration..., New
Spectrum View Configuration..., and Remove Selected Items.

Note

All these operations can also be selected by right-clicking on
a plot or chart and selecting from the context menu that
appears.

e Save Spectrum View Configuration — Enables you to save the current
configuration of open plots and charts, including their specific display
parameters. The current data, however, is not saved.

1. In the Save Spectrum View Configuration dialog, type in the
Name for your configuration or select the name of a previously
defined configuration.

Note

The name you type also appears on the Spectrum
and Spectrum(2) tabs, so we suggest that you use
something short but descriptive, for example,
“Plots Only”, “Charts Only”, “Duty Cycle Charts
and Plot”, or “Devices and RF Power”.

2. To make the current configuration the default configuration,
select the Set As Startup Default For This View check box. (If you
select this, the current configuration appears every time you start
AnalyzeAir and select the current tab.)

Note

You can save a separate default view for each
Spectrum tab.

3. Click [OK].

e Open Spectrum View Configuration... — The dialog box for this operation
will list all of your currently saved spectrum views. Select one view and
then click [OK].

e New Spectrum View Configuration — This operation clears all currently
displayed plots.

e Remove Selected Items — This operation will close only the currently
selected plots or charts.
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Deleting a Spectrum View
To delete a saved spectrum view:

1. Do one of the following:

e Right-click on a plot title and select Save Spectrum View
Configuration...

OR
e Select Spectrum > Save Spectrum View Configuration.

2. In the Save Spectrum View Configuration dialog, select an existing
view.

3. Select Remove saved configuration....

Click [OK] in the confirmation dialog box.

Exporting Data

In a Spectrum view, the Export Data feature allows you to export plot or
chart information to a file for future analysis. You can export data from a
single plot or chart or from multiple plots or charts.

From a Single Plot or Chart
Use one of the following methods to export data from a single plot or chart:

e Method 1
1. Select the plot or chart.

2. From the Spectrum menu, select Export Selected Items Data... to
export data from the plot or chart to a user-specified file.

e Method 2
1. Select the plot or chart.
2. Right-click on its title to display a pop-up menu.

3. Select Export Selected Items Data... to export data for your
selections to a user-specified file.

e Method 3
1. Right-click inside a plot or chart area to display a pop-up menu.

2. Select Export Selected Items Data... to export data for your
selections to a user-specified file.
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From Multiple Plots or Charts
To export data from multiple (up to nine) plots or charts:

1. Press and hold the Ctrl key while selecting the desired plots or charts.
2. Do one of the following:

e From the Spectrum menu, select Export Selected Items Data... to
export data from your selections to a user-specified file.

OR

e Right-click on the title of one of the selected plots or charts and
then select Export Selected Items Data... from the pop-up menu
to export data from your selections to a user-specified file.

Sample Export Data File

Following is an example of an exported data file for an Interference Power
chart:

Interference Power

Vertical Scale: 10 dBm/

In-Network
Channel Wi-Fi AP Total Cordless Phones  Wi-Fi CCl Wi-Fi ACI
WiFi Ch. 1 -85 -79.5 -81.2 -85
WiFi Ch. 2 -78.6 -81.2 -82.4
WiFi Ch. 3 -90 -77.5 -81.2 -80.1
WiFi Ch. 4 -73.9 -81.2 -74.9
WiFi Ch. 5 -70.5 -81.2 -70.9
WiFi Ch. 6 -71 -78.3 -81.2 -83 -88
WiFi Ch. 7 -70.3 -81.2 -70.7
WiFi Ch. 8 -84 -69.9 -81.2 -70.2
WiFi Ch. 9 -65.7 -81.2 -65.8
WiFi Ch. 10 -61.9 -81.2 -62
WiFi Ch. 11 -62 -80 -81.2 -87
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Spectrum Plots

The Spectrum Plots use graphical displays to provide detailed, low-level
views of the RF spectrum. The plots are based on data from the Spectrum PC
Card Sensor. In this section, we explain the information displayed in each

plot.
Note
Spectrum Charts are discussed under “Spectrum Charts” on
page 72.

Using Spectrum View Plots

For a discussion of creating spectrum plots, pausing and resuming the
display, and saving plot configurations, see “Working with Spectrum Tabs,
Spectrum Plots, and Charts” on page 46. For a discussion of how to fine-
tune the display of data for each plot, see “Spectrum Plot Controls” on page
63.

Plot Content

Spectrum View offers five different types of plots. We list all five plots here,
and provide more detailed discussion in the following pages. Further
information is available in the Online Help.

Frequency-Based Plots

There are four plots which offer different views of RF power as a function of
frequency. For these plots, the entire plot is updated once per measurement
interval (approximately once per second):

e Real Time FFT
e Power vs. Frequency
e FFT Duty Cycle

e Swept Spectrogram — Combines a time- and frequency-based view of
the RF spectrum.

Time-Based Plot
This plot shows the variation of an RF metric over time.

Power vs. Time — Plots data based on short time intervals (milliseconds).
Mainly used for pulse detection.

Real Time FFT Plot

A Real Time FFT plot displays RF power as a function of frequency, or in
technical terms, a Fourier transform of the RF spectrum. The plot can
provide three different views: the average power (Avg) read during the
most recent measurement interval; the maximum power (Max); or the
maximum power detected at any time since the plot began running (Max
Hold, meaning the plot holds onto the maximum power up to now).

See “Real Time FFT Plot Compared with the Power vs. Frequency Plot” on
page 57 for more information.
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The Power vs. Frequency plot is also a Fourier transform of the RF spectrum,
showing the amount of RF power detected at various frequencies. The
difference between this plot and the Real Time FFT plot is that the Power vs.
Frequency plot is generated based on an analysis of Sensor data. This means
that data can be aggregated and combined in various ways that are not
possible with direct Sensor data, the basis for the Real Time FFT plot.

The information under “Real Time FFT Plot Compared with the Power vs.
Frequency Plot” on page 57 compares the Real Time FFT plot with the Power
vs. Frequency plot.

Four of the five spectrum plots are shown in the following figure. The
highlighted plot (Swept Spectrogram, which has a pale orange background
color, rather than pale blue), is the currently selected plot. (You select a plot
by clicking on it.)

So, for example, if you select Spectrum > Pause Selected Items, it is the
Swept Spectrogram plot which is paused.
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Center:2.450 GHz Span:100.00 MH2 Center:2.450 GH2 Span:100.00 MHz
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race 3 0fF [ Trace 3 Off
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FFT Duty Cycle nrax Swept Spectrogram n?ax
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Power vs. Frequency, Real Time FFT, FFT Duty Cycle, and Swept Spectrogram
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FFT Duty Cycle

The FFT Duty Cycle plot displays the percentage of the time that the ambient
RF signal is 20 dB above the noise floor. (This is represented on a per-
frequency bin basis.) The Duty Cycle for the FFT Duty Cycle plot includes all
RF energy, both from 802.11 devices and interferers.

Swept Spectrogram

The Swept Spectrogram is a different presentation of the data shown in the
Real Time FFT and FFT Duty Cycle plots. Each colored horizontal line in the
Swept Spectrogram plot displays the RF power or duty cycle as a function of
frequency, as measured over the time period of one sweep in time (typically
one second). The power or duty cycle values in each sweep are mapped to a
range of colors, and displayed in a scrolling or "waterfall" display. This
allows you to observe the FFT signals over historical time, and easily see
signals with shifting frequencies and various durations. (You select between
the power or duty cycle metrics using the Control Panel.)

See “Interpreting the Swept Spectrogram Plot” on page 60 for more
information.

Note

The color legend for the Swept Spectrogram is only displayed if
there is enough room on screen. Depending on your display
resolution, and on how many plots you have open at once, you
may need to close some other plots in order to see the mapping
of colors to power levels.

Power vs. Time

The Power vs. Time plot displays RF power as a function of time. The time
scales involved are very brief—microseconds or milliseconds—so the plot is
mainly used to observe RF pulse activity.

Real Time FFT Plot Compared with the Power vs. Frequency Plot

Both the Real Time FFT plot and the Power vs. Frequency plot show RF
power as a function of frequency at a given moment in time.
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Real Time FFT and Power vs. Frequency Plots
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However, the two plots differ in important respects, as described in the

following table.

Table 3. Differences between the Real Time FFT Plot and Power vs. Frequency Plot

Property

Real Time FFT Plot

Power vs. Frequency Plot

Data Source

Spectrum PC Card Sensor
Hardware: Raw spectrum data is
collected inside the Sensor, and
statistical analysis is also performed
directly by the Sensor’s onboard
hardware. This enables very fast
analysis of large quantities of
spectrum data, but with the
limitation that the parameters of
the analysis are hard-coded into
the design of the Sensor.

Spectrum PC Card Sensor plus
Microprocessor Software: Raw
spectrum data is provided by
the Sensor and is then
analyzed by software running
on the CPU inside the laptop
PC. This software analysis of
the spectrum data provides
greater flexibility in the
analysis, but with the trade-off
that less data can be analyzed
in a given time frame.

Dwells

For both the Real Time FFT and
the Power vs. Frequency plots,
the FFT analysis is performed on
only 20 MHz of the band at one
time. Each 20 MHz span is referred
to as a “dwell.” By measuring
several successive, adjacent dwells,
it is possible to construct a plot
which is essentially similar to a
Fourier transform of the entire
band (2.4 GHz, 5 GHz, etc.).

Bins and Bin Sizes

Each 20 MHz dwell is divided into
128 bins, where each bin is 156 KHz
wide. A power measurement is
provided for each bin. The number
of bins, and the bandwidth of each
bin, is fixed.

With advanced software
analysis, the number of bins
and the bandwidth of each bin
are user-defined, so you can
achieve much finer granularity
in your power measurements.
For example, a single bin can
be as narrow as about 9.7 KHz.
To get the number of bins
(data points on the plot),
divide the span being
measured by the RBW. For
example, a 20 MHz span, with
an RBW of about 20 KHz, will
have about 1000 points (bins)
on the plot.
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Table 3. Differences between the Real Time FFT Plot and Power vs. Frequency Plot (continued)

Property

Real Time FFT Plot

Power vs. Frequency Plot

Number of FFTs
Per Plot

The Real Time FFT Plot is updated
once per second. Each plot is
actually an average over the 5000
FFTs performed by the Sensor
during each dwell.

The software-based Power
vs. Frequency calculations
generate only one FFT per
second. That one FFT is
shown in the Power vs.
Frequency plot (which is
updated once per second, to
reflect the new FFT).

If you have set the plot to
show an Average over all
FFTs, the calculation is based
on an average of several
preceding FFTs that were
plotted; however, each
successive second in real time
only contributes one new FFT
to that average.

Max Mode

One of the plotting options is to
display the maximum RF power
seen during the measurement
interval. This is possible because
the maximum power can be
selected from among the 5000
FFTs.

A maximum power plot
cannot be created because
actual data is available for
only one FFT per second
(rather than having data for
5000 FFTs, as with the real-
time plot).

Advantage of
Using This Plot

Because the plot shows an average
of all 5000 FFT measurements made
by the Sensor in a second, you are
more likely to see spectrum results
from devices that are frequency
hoppers, or bursty transmitters.

You can achieve much finer
control over the granularity
of the spectrum that you see.

Disadvantage of
Using This Plot

You cannot control the granularity
of the spectrum.

Since you only see one FFT
for the entire one-second
measurement interval, you
are less likely to see either
frequency hoppers or bursty
devices.
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Table 3. Differences between the Real Time FFT Plot and Power vs. Frequency Plot (continued)

Property Real Time FFT Plot Power vs. Frequency Plot
Playback Mode This plot can be played back This plot can only be viewed in
historically, as well as viewed real time, not historically.
in real time.
Primary Application The primary use of this plot is The primary use of this plot is
for looking at broad RF for troubleshooting,
spectrum activity, covering an particularly for identifying and
entire band. This is useful for analyzing the spectrum
tasks like site surveys and behavior of an unknown
initial network deployment. interferer. It is often most
effective when looking at less
than a full band.

* This applies to Power vs. Frequency plots only and not to the Real Time FFTs. When you create
the Power vs. Frequency plot, the very first plot shows a single FFT. And—again, assuming the plot
is set to be in “Averaging” mode—the second plot adds one new FFT, and averages that with the FFT
from the first plot. Each second, one more FFT is added to the average. However — the average is
not performed over all preceding FFTs, but only for a more limited number, those included in a
process known as “video averaging.”

Interpreting the Swept Spectrogram Plot

This section provides an illustrated discussion of interpreting the visual
display in the Swept Spectrogram plot. Color coding is used to indicate
intensity of either RF power or RF duty cycle (depending on which you
choose to plot, using the Spectrum Control Panel).

113 dBm -42 dBm

eib16s.omp

Swept Spectrogram Color Mappings: RF Power

(CEE 100 b

eyb103s.tif

Swept Spectrogram Color Mappings: Duty Cycle
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Shown below is a comparison of how the same RF power measurements
might look if plotted using a standard line graph—with the height of the
graph indicating RF power—compared to using colors on a straight line as a
means to indicate power levels. Here, blue indicates less power, yellow
indicates more power, and red indicates the most power.

RF
Power

E

2.4 GHz 2.5 GHz
erb30s.tif
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This is the very first sweep you see upon starting the plot. It represents the
RF power (average power, or maximum power, or duty cycle power, per your
selection) as a function of frequency — and at the present moment.

The amount of power at each frequency is represented through the color
coding scheme.
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TimeT=2:
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In the next measurement interval (typically one second later), the previous
measurement “slides up” one level, becoming Sweep -1. A new sweep,
representing “now"”, replaces it at the bottom, becoming the new Sweep 0.

TimeT=n:

Sweep
-164

Sweep 0
2.4 GHz 2.5 GHz

erb33s.tif

We continue, measurement interval after measurement interval, with older
measurements of RF power sliding up, and the latest “now"” appearing at
the bottom. By mentally visualizing a vertical “slice” of the graph, you can
see how the power levels have changed at a selected frequency going back
in time. (The Up arrow points from the present to the past.)
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What If No Data Is Showing?

Note

Under “What If I'm Not Seeing Any Data?” on page 41, we
discuss several potential reasons why you may see no data or
appear to see no data in AnalyzeAir. We repeat here, in
summary form, one particular issue which is unique to the
spectrum plots: incorrect amplitude settings.

With spectrum plots, you may fail to see any data if the range of the
amplitude setting (the lowest and highest power values shown on the plot)
is inappropriate for the actual data being monitored. This can be a problem
with any of the plots, but particularly with the Swept Spectrogram, where
RF power values and duty cycle values are mapped to colors.

If all the measured data falls in a very narrow range compared with the
Color Scale, you may see nothing but a solid block of a single color — in fact,
you are seeing the correct data, but it seems as if you are seeing no data at
all. Selecting the [Auto Scale] option on these plots should correct this
problem, but sometimes it helps to manually adjust the measurement scale.
See “Amplitude” on page 64.

Spectrum Plot Controls

The plot Control Panel lets you fine-tune the data presented by the plots.
Each plot has its own plot-appropriate controls. However, many of these
controls are common to more than one plot. We discuss the typical controls
here. The Online Help fills in additional plot-specific details.

Frequency and Bandwidth to Monitor

Several plots provide measurements of RF power (average power, maximum
power, etc.) as a function of frequency. The RF frequencies are presented as
a range across the horizontal axis. Frequency settings enable you to
establish the range of the X-axis. Even for the time-based plots, however,
you can still set the band and/or channel that AnalyzeAir will monitor.
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i Control Panel
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Start/Stop Freq %
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You can select the frequency to be monitored based on a Center Frequency
and Span, a Start/Stop frequency, or specific Channels. After you make a
selection, AnalyzeAir automatically fills in default values for the Center
frequency and Span, or the Start and Stop frequency. However, you can
edit these default values.

e If you change the default Center frequency and frequency Span, or
the Start and Stop frequencies, you may no longer be plotting
entirely “in channel” or “in band.” However, AnalyzeAir will not
permit you to set frequencies that are outside the hardware
capabilities of the sensor technology. In this sense, the technology is
“error proof”.

e You can change the bands available here—that is, the bands shown
on the Frequency menus—by changing the Monitored Bands settings
(Tools > Settings - Monitored Bands). See “Monitoring” on page
102 for more information.

e You can change the channels available here by changing your
Channel Settings (Tools > Settings & Channel Settings). See “Band
and Channel Settings” on page 100.

Note

AnalyzeAir will only make available for selection those
channels that you have selected under Channel Settings
provided that those channels also fall within the bands
you have selected under Monitored Bands.

The Power vs. Frequency plot also has a Bandwidth setting, which
determines the size of each bin for RF power measurements. See “Power vs.
Frequency Plot” on page 70.

- Bandwidth[v] suto Select
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Amplitude

64

Amplitude settings enable you to set the scale for the vertical axis. The
exact measurements will depend on the type of measurement being made.
For example, RF power measurements are in dBm, while duty cycle
measurements are in percentages (since the duty cycle is typically defined as
the percentage of time that an RF signal is above some threshold value

or the percentage of time that an RF signal is detected from a network
device or interferer).

- amplitude Auko Scale

Reference | -70 dBm
Vertical Sca 3 dBm |
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Reference Level refers to the value at the top of the vertical axis.

Vertical Scale refers to the change in value represented by each tic-mark on
the vertical axis.

In general, the bottom of the scale is Reference Level — (10 * Vertical Scale).

Example: [f the Reference Level is -25 dBm, and the Vertical Scale is set to 8
dBm, then the top of the scale is -25 dBm, while the bottom of the scale is -
25 dBm - (10 * 8 dBm) = -105 dBm.

If you click [AutoScale], AnalyzeAir automatically selects the optimum
calibration for the vertical scale, based on recent power measurements.

-105 clBm

Start: 2 400 GHz
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Trace Settings
A trace is the line that actually plots the RF data of interest.

You must select the On radio button for at least one Trace, in order to see
any data at all.

~ Trace 1 (=1on (DOf
Type Bax

- Trace2 @on OOF [Clear |
Type BMax Hold

- Trace3 ®on (O
Type BrpErage FJ

erb37s.omp

For some plots, you can have more than one Trace, and you can select the
type of data each trace displays (such as Average RF power, Maximum RF
power, Max Hold RF power, Max - 5 Sweeps, etc.). The Online Help
describes these options in detail.

Max Hold maintains a display of the highest RF power measured since you
began the current session. The [Clear] button deletes the Max Hold Trace
and starts a new maximum power trace, starting from the moment when
[Clear] is selected.
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Markers

A marker is a small icon on the plot which is displayed on the graph at a
particular point along the X-axis, in other words, at a particular frequency.
The marker moves up and down according to the movement of the graph at
that fixed point. The marker is the small box displayed at the bottom trace
in the plot shown as shown in the following figure:

eyb117s.tif

e On/ Off — Indicates whether the marker is on or off; that is, in use at all.
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e Type — A Single marker is a marker that is displayed on the trace. If you
select Delta, you will initially see a single marker on the plot. However,
you can select the marker with your mouse pointer (click and hold on the
marker) and slide it to a second location on the plot. You now have two
markers on the trace so that you can see the difference in behavior
between two different frequencies.

e Trace - For plots that allow more than one trace, use the drop-down list
box to select which of the traces the marker will ride.
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¢ Value - Indicates where along the X-axis (the frequency or time axis) the
marker should ride the plot.

e You can indicate the frequency value using the Value text box. However,
once the marker is visible on screen, you can grab the marker (click and
hold the left mouse button), and drag the marker to a new location (a
new frequency or time).

e Peak Search — As the spectrum plot is traced, the plot is continuously
updated with the value of the peak marker to identify the peak during
each cycle. You can select this feature for both Single and Delta markers.
It also works with RTFFT, FFT Duty Cycle, and PvF spectrum plot functions.
You can select the following values:

o Highest Peak

o Next Peak Up

o Next Peak Down
o [+JNext Peak Left

o [=INext Peak Right

Setting the X-Axis Position of Delta Markers

For instructions on setting the X-axis position of dual markers, see the
AnalyzeAir Online Help, in particular the topic “Setting Delta Marker
Positions”.

Channels

Some of the spectrum plots use frequency values on the horizontal axis. On
these plots you have, as an option, the ability to superimpose bracketed
indicators of channels, as illustrated here.

You can turn the display on or off by using the Channels radio buttons:

- Channels (= 0n ) o
Channels 1,5,11 E]

1,6.11
1,4, 7, 11
1,48 11
1,59, 13
2,7, 12 %
3, 10, 14
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The channels shown will be the ones appropriate for the band you are
currently monitoring, taking into account any regulatory domains you have
selected under Channel Settings.

Note

Even if you turn Channels to On, the channels are not shown if
the span of the plot is 20 MHz or less.
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Other Plot Control Panel Settings
This section describes other Plot Control Panel settings.

Power vs. Time

The Power Vs. Time plot is used to display short bursts of RF activity, known
as “pulses”.

e Sweep Time — This sets the time scale over which pulse activity is
measured. Specifically, it sets the range of the X-axis, which will run
from a low value of -SweepTime up to the present. You can use the
spin control to change the setting, or type in a value directly. Type
“ms” for milliseconds and “us” for microseconds. For example: 150
us.

The plot also has a specialized Bandwidth setting:

e RBW - Determines the span of the spectrum monitored for power.
This works in conjunction with the Center Frequency setting for the
same plot. The low end of the monitored band is Center Frequency -
RBW/2, and the high end is Center Frequency + RBW/2.

e Autoselect — Select this check box to have AnalyzeAir automatically
determine the optimum bandwidth to monitor.

Note

This is not the same definition for RBW that applies for the
Power vs. Frequency plot (discussed later), where RBW sets
the bin size for the X-axis.
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The Power vs. Time plot also has a series of Trigger settings. Trigger criteria
determine both what kinds of RF pulses are displayed, and when the display
is updated.

Trigger Type — This determines when the plot is updated.

o Free Run - RF energy (in your selected bandwidth) is sampled
on a continuous basis, and data is “"dumped” to the screen as it
is available. This means the display is updated on a nearly
constant basis, and data is shown whether or not any RF pulses
are detected.

o Single - This catches a single pulse only. The display is only
updated when an RF pulse is detected which matches your
Trigger Threshold criteria (discussed later). If you select Single,
you must then click [Arm] (discussed later).

Once such a pulse event is detected, it is displayed on the plot,
and the plot is then frozen — no further activity is displayed. To
catch any further pulses, you click again on [Arm].

o Continuous — The plot is only updated when AnalyzeAir
detects RF pulses which match your Trigger Threshold criteria.
However, after detecting a pulse, the plot automatically “re-
arms” itself, meaning every time a new pulse comes along, the
plot is updated with new data. (Once again, the pulses are
only shown if they also fall within the bandwidth you have
indicated, using the options described earlier.)

[Arm] - If you have selected a Trigger Type of Single, click [Arm] to
tell AnalyzeAir to be on the lookout for the next pulse that comes
along.

Trigger Threshold — This indicates the minimum power that an RF
pulse must attain in order to register as a pulse, for purposes of this
plot. That s, in order to be counted as a pulse at all, for purposes of
this plot, an RF pulse must exceed the amount of power you indicate
here. Units are in dBm, where 0 dBm is equivalent to 1 milliwatt.

For example, if you indicate -10 dBm, then a pulse which reaches -5
dBm will be displayed, while a pulse whose maximum power is only
-12 dBm will not be displayed.

Note

After the trigger line is shown on screen (as a white
horizontal line), you can also change the setting by
clicking and holding the line with the mouse and then
dragging it up or down. The current Threshold is
displayed on the plot just above the line.
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e Trigger Delay — This adjusts the centering of a pulse on your display.
The default value is 0. With this setting, the beginning of an RF pulse
is always centered on the midline of the time axis. If you set this to a
positive value, the beginning of the RF pulse is offset to the left. If
you set this to a negative value, the beginning of the pulse is offset
to the right.

Power vs. Frequency Plot

70

¢ Bandwidth — The Power vs. Frequency plot has a Bandwidth setting,
which determines the size of each bin for RF power measurements. A
"bin" is the smallest span of spectrum for which power
measurements are displayed.

o Autoselect - If you select this check box, AnalyzeAir
automatically picks the optimum bin size. The value selected
by AnalyzeAir will vary depending on the total bandwidth you
choose to measure (using the Frequency settings).

o RBW - RBW stands for "resolution bandwidth". Effectively,
the bin sizes for RF power measurements will be just slightly
larger than the value that you enter here. (So, for example, if
you enter 60 kHz, your bins will be roughly 70 to 90 kHz wide.)
You can only enter a value here if you first de-select the
Autoselect check box.

Note

This is not the same definition for RBW that
applies for the Power vs. Time plot (discussed
earlier), where RBW sets the size of the total
bandwidth being monitored.

When you enter a value for RBW for the Power vs. Frequency plot,
AnalyzeAir may "auto-adjust" your entry to the nearest valid value. The
formal definition of RBW is the 3 dB bandwidth of the detection filter.
The RBW determines the minimum frequency spacing that is allowed
between two pure frequencies, in order for the frequencies to actually
be distinguished as separate signals.

Example: If RBW is set to 70 kHz, then two signals which are separated
by only 60 kHz in frequency will appear as one signal, with a combined
power measurement for both signals.

Total Number of Bins — The total number of bins is approximately the
Span being monitored divided by the RBW.
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For example, if a 100 MHz span of the spectrum is being viewed—and if
that span is divided into bins of 2 MHz in size—then the plot displays 50
separate power readings, indicating the power detected in each separate
2 MHz bin.

Note

The minimum number of bins is never less than 16, and
the maximum number of bins on the plot is at most
1024. If you try to establish settings for the Span and
RBW which would cause higher or lower bin values,
AnalyzeAir will auto-adjust the RBW or Span setting to
bring the number of bins within the allowed range.

The Power Vs. Frequency plot also has a series of Trigger settings, similar to
those for Power Vs. Time:

Trigger Type — This determines when the plot is updated. Use the
drop-down list box to select one of the three options.

o Free Run - RF energy (in your selected bandwidth) is sampled
on a continuous basis, and data is “"dumped” to the screen as it
is available.

o Single -The display is only updated when RF energy is
detected which matches your Trigger Threshold criteria
(discussed later). If you select Single, you must then click on
[Arm] (discussed later).

After such RF energy is detected, it is displayed on the plot,
and the plot is then frozen — no further activity is displayed. To
catch any further activity, you click [Arm] again.

o Continuous — The plot is only updated when AnalyzeAir
detects RF energy that matches your Trigger Threshold criteria.
However, the plot automatically “re-arms” itself, meaning
every time a RF energy comes along which exceeds the Trigger
Threshold, the plot is updated with new data.

[Arm] - If you have selected a Trigger Type of Single, click [Arm] to
tell AnalyzeAir to be on the lookout for the RF energy which exceeds
your Trigger Threshold.

Trigger Threshold — This indicates the minimum RF power must be
seen in order to update the plot. Units are in dBm, where 0 dBm is
equivalent to 1 milliwatt.

For example, if you indicate -10 dBm, then RF energy which reaches -5
dBm will cause the display to be updated, while RF energy below -10
dBm does not result in any update.

Note

After the trigger line is shown on screen (as a white
horizontal line), you can also change the setting by
clicking-and-holding on the line with the mouse, and
dragging it up or down. The current Threshold is
displayed on the plot, just above the line.
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Swept Spectrogram

The Swept Spectrogram plot uses colors to represent RF power levels. The
Color Scale options enable you to map the “highest color” and “lowest
color” to specific power levels.

113 dBm 33 dBm
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Here, the color blue has been mapped to -110 dBm, while Red has been
mapped to -30 dBm.

Values below the minimum value (-110 dBm, in this case) are automatically
mapped to purple, while values above the maximum value (-30 dBm here)
are automatically mapped to white.

-l Color Scale Auto Scale

Maximum  -30 dBEm

Minirnum -110 dBm

4|

erb41s.tif

Note

For the Swept Spectrogram, the color scale is only visible when
there is enough room to display it on screen. Depending on how
many plots you have open, and on your display monitor
resolution, you may need to close some plots to see the color
scale.

[Auto Scale] chooses appropriate upper- and lower-values based on recent
power measurements.

FFT Duty Cycle Plot

For the FFT Duty Cycle plot, the scale of the Y-axis is based on a Maximum
and Minimum, where (typically) the Maximum would be 100% and the
Minimum would be 0%.

Spectrum Charts

The AnalyzeAir Spectrum Charts use bar, line, and pie charts to provide
broad summary information about activity in the RF spectrum. Like the
spectrum plots, the spectrum charts are based on data from the Spectrum PC
Card Sensor. In this section, we explain the kinds of information displayed in
each graph.

Using Spectrum View Charts

For a discussion of creating charts, pausing/resuming the display, and saving
chart configurations, see “Working with Spectrum Tabs, Spectrum Plots, and
Charts” on page 46.

Note
Spectrum Plots are discussed under “Spectrum Plots” on page 55.
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Chart Content

Spectrum View offers seven types of charts. We list all of them here and
provide more detailed discussion in the following pages.

e Active Devices

e Devices vs. Channel

e Devices vs. Time

e Channel Utilization

e Channel Utilization vs. Time
¢ Interference Power

e SNR

Active Devices

A pie chart indicates—via different sized “slices” of the pie—what
percentage of your RF activity is coming from different kinds of RF sources.
You select which channel / band to monitor.

Devices vs. Channel

A bar chart displays the number of devices detected on different channels.
You can select which frequency bands or channels will be monitored.

Devices vs. Time

A line chart displays the number of devices detected at different times. You
can select the time interval of interest (ranging from ten minutes up to 24
hours), the channel or band to monitor, and the types of devices which will
be tracked on the plot.

Channel Utilization

A bar chart displays RF duty cycle as a function of channel. You can select
which frequency bands or channels will be plotted. The stacked bars
represent each user selected channel. A stacked bar consists of several
colored segments that represent the duty cycle of each device that is
contributing to the overall duty cycle of that channel..

Two performance alert thresholds are displayed in the background of the
chart. The threshold values and colors are the same as in the Channel
Summary View. The red background color represents the critical threshold
and yellow represents the warning threshold. The default threshold values
are 50% (critical) and 25% (warning).
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Channel Utilization vs. Time

A line chart displays RF duty cycle as a function of time. You can select the
time interval of interest (ranging from ten minutes up to 24 hours) and the
channel or band to monitor. For longer time intervals, you can also select
how data is aggregated — that is, you can track the average duty cycle, the
maximum duty cycle, or the minimum duty cycle.

As with the Channel Utilization chart, performance alert thresholds are
displayed in the background of the chart. The threshold values and colors
are the same as in the Channel Summary View. The red background color
represents the critical threshold and yellow represents the warning
threshold. The default threshold values are 50% (critical) and 25%
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Interference Power

A bar chart shows the power for each selected channel. The height of the
bar indicates the power of all interference signals. Each bar consists of
several lines representing the signal strength of a specific device type. The
receive signal strength of the strongest In-Network Wi-Fi AP on each channel
is shown by a + (plus) sign. The Wi-Fi noise floor is represented by a
horizontal line across the grid background.
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Interference Power Charts for In-Network Wi-Fi AP

The X-axis shows the channels, and the Y-axis shows the signal strength
(from -100 dBm to 0 dBm). The height of the bar indicates the cumulative
power (in dBm) for all devices in this category that affect a given channel.

To view channel and power information:

e Pause the mouse over a stacked bar to display a pop-up of
information about the channel, maximum power, and the signal
strength of each interfering device. Or, pause the mouse over a + sign
to view pop-up information about the channel and the signal
strength of the strongest In-Network Wi-Fi AP.

e Right-click either a stacked bar or + sign to view the same pop-up
menu available on the Devices vs. Channel chart.
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SNR (Signal to Noise Ratio)

A color coded bar chart that displays the SNR for each channel having APs.
The SNR chart also displays signal degradation using green, yellow, and red
zones. SNR is the ratio of a given transmitted signal to the background noise

on the channel.
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SNR Chart

The X-axis shows the channels and the Y-axis shows the SNR power level
(from -50 dB to 50 dB). The height of the bar above or depth of the bar
below the 0 dB line indicates the SNR (in dB) for a given channel. The color-
coded zones indicate the following:

e Grey: indicates SNRs of above 20 dB indicating a good SNR

e Yellow: indicates SNRs between 10 and 20 dB indicating a less than
good but better than critical SNR

e Red: indicates SNRs less than 10 dB indicating a critically low SNR

Navigating to Other Views
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You can right-click the bars and graph lines on certain charts to obtain
additional information on a particular channel. You can navigate from
Spectrum View to Devices or Channel Summary View.

On the following plots/charts: Channel Utilization, Devices vs. Channel, Real
Time FFT, FFT Duty Cycle, Swept Spectrogram, and Power vs. Frequency
right-click on a channel bar (or anywhere in the workspace of the plot) to
display the pop-up menu. Select Show Devices Affecting <channel ID> to
display the active devices in Devices View. Select Show Channel <channel
ID> to display related data on this channel (highlighted in blue) in Channel
Summary View.
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Chart Controls

The chart Control Panel lets you fine-tune the data presented by the charts.
Concerning band and channel selections, note that the channels available
for selection are those that meet both of the following conditions:

e The channels are selected under Channel Settings.

AND

e The channels fall within the bands selected under Monitored Bands.

You can change the channels available here by changing your Channel
Settings. Select Tools > Settings > Channel Settings. See “Band and
Channel Settings” on page 100.

You can also change the bands available here—that is, the bands shown
on the Channel menus—by changing the Monitored Bands settings.
Select Tools - Settings - Monitored Bands. See “Monitoring” on page
102 for more information.

Channel or Band Selection for Channel-Based Charts

Charts that use the RF channel as the independent variable (on the X-axis)
include the Channel Utilization chart and the Devices Vs. Channel chart.
These charts enable you to select exactly which channels will be displayed on
the chart.
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For each band supported, a drop-down list box enables you to select one of
three options:

e All Channels - All channels in the band will be charted.

e Channel Range - If you select this option, select a From channel (the
lower end of a range) and a To channel (the upper end of the range)
using the drop-down list boxes.

¢ None - None of the channels in the band are charted.

You may need to click on the [+] tree control buttons to expand visible
options for each band displayed on the Control Panel.

The Active Devices chart, which is a pie chart, has no X-axis. The pie chart
simply shows the distribution of different device types in a selected band or
channel.
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Selection Options for Time-Based Charts

The Devices vs. Time and Channel Utilization vs. Time charts both use time
as the independent (X-axis) variable. The two charts have similar, but
slightly different controls.

Devices vs. Time
This section describes the controls for Devices vs. Time.
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For Devices vs. Time, you can select:

¢ Interval — The total time interval for the X-axis. For example, if you
select 8 hours, the chart will display the number of devices seen over
time period extending from “now” back to “now minus 8 hours.”

e Channel — Use the Channel listbox to select which channel or band to
monitor.

e Trace — The chart can show usages for up to four different types of
devices at one time. For each of the four traces (represented as
different colors on the chart), you have the following options:

o On/Off — Indicates if the trace is in use at all.

o Category - Indicates the type of device to be tracked by the
trace. Options include 802.11 devices, microwave ovens,
cordless phones, etc.

o Aggregation — For time intervals of 8 hours or 24 hours, each
“point” on the plot actually spans a significant period of time
in its own right. You can select whether, for each point on the
plot, you are seeing the Average number of devices active in
that time interval, the Maximum number of devices seen in
that time interval, or the Minimum number of devices seen in
the time interval.

For shorter total time intervals (4 hours or less), this option is
not available. For these shorter timeframes, each point on the
plot represents a short enough time period so that you do not
need to distinguish between the minimum/maximum/average
number of devices. The average value is automatically shown.
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Channel Utilization vs. Time

For Channel Utilization vs. Time, the options are similar to those for Devices
vs. Time, but not quite the same.

: Control Panel q x
= Metric

Interyal & hours
- Trace 1 ) on (@ ]a

Chanrel WiFi Ch. 1

Mogregation Average
- Trace 2 (%) 0n (@]
Channel WiF Ch. 1

fpgregation | Mactimium

= Trace 3 & 0n Okt
Channel WiFi Ch. 1
Aggragation  Mnimum B

erb44s.omp

You can select the following:

Interval — The total time interval for the X-axis. For example, if you
select 8 hours, the chart will display the number of devices seen over
time period extending from “now” back to “now minus 8 hours.”

Trace — Here, each trace, rather than corresponding to a device type,
corresponds to a band/channel and/or to a different type of data
aggregation. The chart can show up to four different traces at a
time. For each of the four traces (represented as different colors on
the chart), you have the following options:

o On/Off — Indicates if the trace is in use at all.

o Channel — Use the Channel list-box to select which channel or
band to monitor.

o Aggregation — For time intervals of 8 hours or 24 hours, each
“point” on the plot spans a significant period of time. You
can select whether, for each point on the plot, you are seeing
the Average duty cycle in that time interval, the Maximum
duty cycle, or the Minimum duty cycle.

For shorter total time intervals (4 hours or less), this option is
not available. For these shorter timeframes, each point on the
plot represents a short enough time period that you do not
need to distinguish between the minimum/maximum/average
duty cycle. The average value is shown automatically.
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Devices View

The Devices View shows detailed statistics for each device, including both
currently active devices and historical devices. Devices listed here include
both network devices and interferers. You access this view by selecting the
Devices tab. The data in Devices View is organized in tabular form.

80

Device — The name of the interfering device.

Signal Strength — Average received signal strength (log average) for
pulses from the device.

Duty Cycle (%) — Measured duty cycle for this device.
Discovery Time — When the device was first detected.

On Time — Amount of time the device has been on since it was
detected.

Channels Affected — Channels affected by transmissions from this
device.

Network ID — Network address for this device, if available (for
example, the BSSID for 802.11 device, or the piconet address for
Bluetooth devices).

Device ID — The device address for the device, if available. Examples
are the MAC address for 802.11 APs, the device address for Bluetooth
devices, etc.

If there is more than one instance of a device type, the number of instances
is shown in brackets (for example, [5]) in the Device field.

Spectrum Spectrum (2 i Channel i -
[ APQ 2.4 GHz { 55&: an 2.4(632 Devices ( Summary I’/O Device Finder I
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signal | Duty ‘ ‘ ‘ ‘ ‘ ‘
Strength | Cycle Channels fAwg Pulse
Device | 4 (dBm) |{%3 "% Discovery Time ©On Time Affected Metwork 1D Details Device ID Duration
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REWIFIZ {Ch 1) -53.0 Tue Aug 29 001215 1.4 WEP Enabled... 00 19E Nia
REWIFIZ (Ch 11} -54.0 Tue Aug 29 13 001215 8,13 WEP Enabled...  00:0B:B5:66:79:5E Nig
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Note

In the default view, not all the fields are shown. You can add or
delete columns, as discussed in the next section under “Adjusting
the Column Display”.

Working with Devices View

This section shows you how to modify the display of information in the
Devices View.

Adjusting the Column Display

Resize Columns - You can resize the columns by selecting the dividing
line between columns then dragging the line to the left or right.

Change Column Order — You can change the order of columns by left-
clicking-and-holding on a column heading and dragging the column
to the left or right. (This works exactly the same as moving columns
in the Windows Explorer.)

Note

In Tree View, you cannot switch the placement of the
Device column.

Add or Delete Columns — Not all of the available columns needs be on
display at one time. In fact, in the default view, several columns are
normally omitted.

o You can add any of the available columns by right-clicking on
the column headings. From the pop-up menu, select Add
Column > <column name>.

o You can delete a column by right-clicking on any column
heading. From the pop-up menu, select Remove Column.

Saving The Current Column Settings — Your current column settings
are automatically saved when you exit AnalyzeAir.

Restore The Default Column Settings — You can restore the default
column configuration by right-clicking on the column headings. From
the pop-up menu, select Use Default Column Settings.

Column Definitions — To obtain a definition for any column, place the
mouse pointer over the column heading. A definition for that
column heading appears in a tooltip window.
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Selecting the Display Type
There are two viewing modes available in Devices View.

e Tree View - In this view, devices in the first column (Device) are
organized hierarchically, first under a device type heading, then
under a network master (for example, AP, base station) heading. This
is the default view after start-up. The following device type headings
apply for the tree view:

@)

0O O O O O o o

Wi-Fi APs

Wi-Fi Ad Hocs
Bluetooth Piconets
Cordless Phones
Microwave Ovens
Continuous Transmitters
Burst Transmitters

Chirp Transmitters

e List View — In this view, there is no hierarchical organization for
Device data. In addition, two additional columns are available:
Category and Network Name.

You can switch between these two viewing modes by selecting the Tree
View or List View radio buttons in the Control Panel on the left side of
AnalyzeAir. (If the Control Panel is not showing, select View - Control

Panel.)

Setting the Time Range

You can set the time range for which devices will be listed by using the drop-
down list box on the Control Panel.
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Sorting the Display
You can sort the data in the Devices View by any of the column headings.

e Primary Sort Column - The primary sort is invoked by left-clicking on
the column heading. The primary sort column is indicated with a
single tick-mark.

e Secondary Sort Column — The secondary sort is invoked by holding
the <Shift> key while left-clicking on the column heading. The
secondary sort column is indicated with a double-tick mark.

The sorts do not affect the outline headings in the Device column (the first
column) for the hierarchical viewing mode; for this mode, the sort is applied
only to the data at the lowest level in the hierarchy for each outline
heading. The default sort order is:

e Primary — Device (ascending)
e Secondary — Duty Cycle (descending)

Ascending and Descending Sort Order

For any given column, you can toggle between ascending sort order and
descending order simply by clicking on the column heading. (If the column
is currently sorted in ascending order, click once to sort it in descending
order. Click it again to restore it to ascending order.)

This works exactly the same for the secondary sort column - repeated shift-
clicking toggles between ascending and descending order.

Keeping Your Eye on a Particular Device

If there is a particular device that is of interest to you, you can keep an eye
on the device simply by clicking on it. Your selected row will be highlighted.
As new devices are detected (or disappear from view), the Device List will
auto-scroll and auto-sort. However, AnalyzeAir will make sure your
highlighted row always remains in view. (In other words, auto-scrolling and
auto-sorting will be adjusted so that the highlighted row always remains
visible on the display.)

Locating a Device

Device Finder mode enables you to use your PC as a “sniffer” to track down
a specific interfering device. Device Finder is discussed in detail under
“Device Finder” on page 87.

To get started, you can right-click on any interfering or AP device shown in
the Devices View. Assuming the device is currently transmitting, you can
select Find This Device from the pop-up menu. This starts the Device Finder
mode. If the selected device is not currently active, the Find This Device
option will be grayed out.

Note

The Device Finder locates only certain types of devices. If you
right-click on a device that cannot be located, the Find This
Device option is not available. Note also that a device must
currently be active (that is, transmitting) to be located. In the
Devices View, if you click on a device that is not active, the Find
This Device option is not available.
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Obtaining Detailed Information on a Device

To obtain detailed information for any device, double-click on the device in
the list. A pop-up dialog box appears showing detailed information for that
device.

Miscellaneous Device Issues

This section describes miscellaneous issues that affect data displayed in the
Device View.

Signal Bounce and Fading

Narrowband signals—such as signals from analog FM cordless phones or
analog video cameras—are prone to fading. Signals naturally fade (grow
weaker) with increased distance from an RF signal source. As a technical
term, fading refers to the fact that as a signal travels, it bounces and reflects
off of multiple surfaces. So, at some distance from a single source, that
single source of RF power results in multiple signals (all from the same
source) crisscrossing each other.

When a single RF signal—reflected from multiple directions—crosses paths
with itself, the result is signal interference. Signal interference can be
constructive (resulting in a stronger signal at a given point), or destructive
(resulting in a weaker signal, or even no signal, at a distance not at all far
from the original source).

The result is that, at a given receiving antenna, the signal can vary greatly in
power when the antenna is moved just a few inches in any direction. To
further complicate matters: As people and other objects in the environment
move, the source signal is reflected differently. So even if the receiving
antenna stays in one place, signal strength can vary unpredictably over time.

As a result, when AnalyzeAir is detecting a narrowband interferer, the
detection status may toggle on and off due to fading. Fading occurs in most
indoor environments, and the fluctuations in received signal level are
typically correlated to the rate of motion for nearby people/objects.

Near/Far Effect

The presence of strong signals may further impair the ability of the
classification software to detect weaker signals. This is the so-called near/far
effect, which is caused when the strong and weak signals use up the limited
dynamic range of the receiver. (In other words, the receiver can only handle
so much signal strength, in total, at one time. So if the receiver is getting
two signals, the stronger one can essentially swamp the weaker one.)

Example: When you walk near one cordless phone while you are
simultaneously listening to another cordless phone that's far away (for
example, at your next-door neighbor’s house), you may find that you lose
the weaker signal. When you turn off the nearby cordless phone, you may
find that you can detect the weaker signal again.

These effects cannot be removed by AnalyzeAir. We make you aware of
them so that you can understand why certain interferers fade in and out of
view at times.
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Device Detection Time

In general, the time required for AnalyzeAir to detect and classify devices
(and reclassify their status, if they go from being On to Off) varies depending
on RF environment and location of devices relative to sensor. In general,
most devices (other than 802.11) should take approximately 5 to 30 seconds.
However, 802.11a/b/g devices and 802.11 frequency hoppers may take as
long as ten minutes to be detected.

Channel Summary

The Channel Summary shows specific levels of RF activity, such as average
power and maximum power, and whether or not interferers are present, on
a channel-by-channel basis.
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Channel Summary

This information is very helpful in determining whether channel
reallocations might improve your network performance.

Working with the Channel Summary
To access the Channel Summary:

e Select the [Channel Summary] tab
or

e Select View - Channel Summary
Sorting the Display

You can do a column sort of the display simply by clicking on the desired
column heading.
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Channel Data

The following data is presented for each channel:

Channel — The channel number. (The display is sorted by channel
number by default.)

Center Frequency — The center frequency of the channel, in MHz.

Wi-Fi Present? — A check mark (V) in this field indicates that
AnalyzeAir detected activity by an 802.11 device during the last
measurement interval.

Channel Utilization (%) — The current duty cycle of RF activity in that
channel. In this case, the percentage of the time that some signal
was present in the channel during the last measurement interval.

In-Network AP Max Power (dBm) —-The maximum power level (in
dBm) of the strongest in-network Wi-Fi (802.11) device on the
channel.

Interference (dBm) — Power level (in dBm) of the total interference on
the channel (including Wi-Fi interference).

SNR (dB) — The signal-to-noise ratio (expressed in dB) for each channel
that has APs present.

In-Network AP(s) — The number of Wi-Fi ACls identified as in the
network and transmitting on the channel.

Known APs — Network devices (APs) that are impacting the network
but are not actually part of the network (for example, APs from
neighboring Wi-Fi networks).

Unknown APs — APs designated as not belonging to the network and
not belonging to a nearby network. Unknown APs should be treated
as potential rogues.

Interferers — The number of non-Wi-Fi devices transmitting on the
channel.

Ad hocs — The number of APs that belong to a temporary (Ad hoc)
network and transmitting on your network channel (not displayed by
default).

Miscellaneous Channel Summary Issues

802.11 Detection Sensitivity

The threshold for AnalyzeAir to detect 802.11 devices is an RF power of
approximately -80 dBm. This detection sensitivity is commensurate to that of
a reliable 54 Mbps connection. In a large environment, users should take
detection measurements at several representative locations to cover entire
area 802.11.
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802.11 Device Types

When AnalyzeAir indicates that an 802.11 a/b/g signal is present on a
channel, this may or may not indicate an AP or network in use. It could also
be a zero config client (a station not currently affiliated with a network)
which is transmitting probes, as it seeks out a network.

Problem Indicators

Performance alert triggering allows you to enable or disable alerts for
problematic channel devices being displayed in the Channel Summary View.
See “Alert Settings” on page 103 for channel summary alert information.

Device Finder

In Device Finder mode, AnalyzeAir acts as a lightweight portable probe
which enables you to quickly track down the location of a specific
interfering device. Essentially, your AnalyzeAir-enabled PC acts as a wireless
“sniffer.”

Overview

Here we present a summary description of how to put Device Finder to
work. Detailed instructions are presented in the next subsection.

1. From the Devices View or the Active Devices tree, select the device
that you want to locate.

2. Carry the AnalyzeAir system to different locations in the network
environment.

3. At each location, use AnalyzeAir to measure the signal strength from
the device of interest.

4. Using these signal strength measurements, identify when you are
closer to—and further from—the device of interest.

Essentially, the signal strengths indicate when you are “getting
warmer” or “getting colder” in terms of getting near to the signal
source of interest. Based on these measurements, you can then home
in on the location of the intruding device.

5. You can also use the Measurement Log to record RF signal strength
levels at specific locations.

If the “warmer/colder” approach is proving problematic—which may
happen if, for example, the signal is intermittent—the log keeps a
record of where different RF levels were recorded. You can use this
information, possibly with the help of a map of your network space,
to triangulate the location of the interfering device.
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Working with Device Finder
To use the Device Finder:

1.

In Devices View or on the Active Devices tree, select the device you
want to locate.

Right-click on the name of the device and then select Find This Device
from the pop-up menu.

Devices: Currently Active, &l Channels
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The device is now listed in the Device Finder.

The Signal Strength History graph shows a moving plot of the signal
strength. (The plot does not automatically reset if the signal is lost.)
This plot makes it easy to visualize when you are walking towards or
walking away from the source of the signal.

Target Signat Device (Cw) @ 2412.93 MHz
Fix Signal Stenath

Time Since Last Update: 0 seconds
Last Update Time: 04/19/06 033015

| ———

R Signal Stiength History
E The black box around one of the bars on the meter
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40 divg—

60 dBrm—]

Pouer (dBm)

80 dBrm—]

Maw Strength (dBr): VB

50+0

An increase in signal strength
indicates a high probability that you
are moving closer to the device.

120 dBm—!

Cur. Stiength [dBm}

-56 £ 0

Time minutes)
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The Rx Signal Strength meter also provides a real-time indicator of
the signal strength from the device of interest, and is an additional
tool in determining whether you are “getting warmer” or “getting
colder” in terms of tracking down the interfering device.
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3. To maintain a record of the signal of interest, click the
[Record Signal] button or press the <Spacebars.

|_Recod Signal | | Clearlog |
Ir‘gl!.

erb48s.tif

AnalyzeAir records the current signal strength and the time in the
Measurement log. For a Description, AnalyzeAir uses the device
name as a default value.

4. Type a description that indicates where the measurement was taken.

5. Press the <Enter> key to confirm your description.

Meazurement Log

Time Drezcription R dBm
0%25094M  |Location 3 - Base Station 1 - Conference Room| | A3 x0
092333 A Location 2 - Morth Conference Foom B4 +0
09:21:42 Abd Location 1 - East Conference Room B3+1

erb47.bmp

6. You can also edit the location information in the Measurement Log
at a later time. To do this:

a) Double-click on the description, and then key in your new
description

b) Press <Enter>.

Note
Press <Esc> to cancel any changes you make.

Additional Device Finder Features
The Device Finder has the following additional features and capabilities:

¢ Reset Signal Averaging — If you click the [Reset Signal Averaging]
button, AnalyzeAir no longer uses prior signal values to calculate the
average signal strength. Instead, AnalyzeAir only calculates average
signal strength from "now" forward, where "now" is when you click
[Reset Signal Averaging].

If you are moving around—or changing the orientation of a
directional antenna—this command causes the signal averaging
measurement to restart, so you don’t display data that may be
representative of the prior position/orientation. A great deal of
filtering is applied to provide accurate measurements. This filtering
can help AnalyzeAir respond more quickly and not be biased from
prior measurements.
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e Clear All Measurements — You can clear all signal strength
measurements and restart the trace by clicking this button.

i Control Panel o x

[ Reset Signal &wveraging ]

I Clear all Measuremenks

b

[ Stop Finding

erb50s.omp

e Stop Finding — You can stop tracking the interferer by selecting the
[Stop Finding] button. It is a good idea to do this after you have
found the interferer of interest, since it reduces the drain on system
processing resources.

e Clear - Click the [Clear] button (over the Rx Signal Strength History
plot) to clear the plot.

e Clear Log - You can clear the Measurement Log of all data by
selecting the [Clear Log] button above the log.

E.Féﬁ&d.éuﬁr.ﬂ. ] | ClearLog . |
y

erb51s.tif

¢ Delete A Single Log Entry — You can also delete an individual row
from the Measurement Log. Simply select the entry, and then press
<Del> above the log.

¢ Reset Maximum Signal Strength — If you click [Reset Max],
AnalyzeAir deletes the current value for the maximum signal
strength; AnalyzeAir then ascertains, starting from "now", the
maximum interferer signal strength measured from this time forward.

¢ [Reset Max] only clears the Max Strength text box and the black
rectangular box in the vertical signal meter that indicates the highest
strength seen. Use the [Clear] button to clear the plot.

Max Strength [dBm} 100 dém
S0=0
120 dBm
Cug. Strength [dBm):
-59+ 0

Fieset Mar |

erb52s.tif
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“Divide and Conquer” Search Strategy

To minimize your effort, and maximize your chances of locating the

interferer, we recommend that you use a “divide and conquer” search
strategy (also known as “rectangular bisection”). We illustrate the strategy,
first with the omni-directional antenna, and then using the directional

antenna. To use this process, you will greatly benefit from using a physical

map of your network space.

Note

It is possible to hit a “blind spot” when using Device Finder. This
is a location—typically a corner of a large building—where you
may not get any measurements at all. If you find you are
spending more than 30 seconds at any one spot, without getting
an updated device reading, you should move away from that
spot and try a different location.

Omni-directional Antenna

For purposes of simplicity, assume that your interfering device is located
somewhere within a large rectangular office space (which might measure,

for example, 50’ by 150°).

1.

Go to each of the far corners of the office space, and measure the
signal strength from the interfering device of interest. Take note of

which corner of the office yields the highest signal strength. (A
printed map of your office space can be helpful for jotting down
data.)

| € &

-B6 dBm 50 dBm
Stage 1: Using the omnidirectional
antenna, measurements are made from

the four comers of the search area

86 dBm -T0 dBm

| & _

Note

Each time you move the AnalyzeAir system to a new
location, click the [Reset Signal Averaging] button on
the Device Finder. Then, at each test location, wait for
the confidence level to settle to a small value—ideally
less than =3 dBm, but certainly less than £5 dBm—before
recording the signal strength.
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i Control Panel o x

LReset Signal Awveraging ]
Pad

Select this each [ Clear &ll Measurements ]

time you move to

a new location to [ Stop Finding l
reset signal averaging.
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This is the confidence level — i -100 dB i
once at a new location (and M ax Stiength [dBm];
after resetting the signal S0+0
averaging).

120 dBm

Wait until it is a small value
before recording a measurement.
It should be less than + 5 dBm.
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2. Inthe corner that has the highest signal strength, map out a
rectangular sub-search area comprising one quarter of the total office
space.

a1

' |
' |
= -54 dBm -60 dBm |
' |
' |
=S |
o & 6
!_{ -48 dBm -60 dBm |

Stage 2: Repeat the same process, only now using one-quarter of
the original search area. The quadrant to use is the one that had the
highest power measurement in the previous stage. (Here, the size
of the quadrant is exaggerated for purposes of illustration.)
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3. As necessary, repeat this process to localize your measurement.

- T 1
| I
| I
[ . S '
|| 50 dBm 52 dBm | |
Il | |
I e _ _ amm | l
________________ 4

Stages 3 through N: Repeat the process again, once more using

one quarter of the original search area, with one vertex at the

location of the highest previous measurement.
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By repeating this process, you can home in on the location of the
interfering device.
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| I
| I
[ 1 '
I 1 |
I TN !
I gEeLe | i

Final Stage: When you have reached a sufficiently localized search area, it may prove
effective to simply search on a grid basis—that is, repeated measurements at relatively
brief intervals—until the strongest readings have clearly identified the location of the
interfering device.
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Directional Antenna

The advantage of using the directional antenna is that you can save yourself
a substantial amount of walking, because four measurements at a time can
be made from one central location. (See “Attaching the Antenna” on page
21 for more on the directional antenna.)

1. Assuming a rectangular office space, take your AnalyzeAir PC to the
center of the office space. Use the directional antenna, with Device
Finder, to determine the signal strength coming from your interferer,
as measured in each of four directions. For each measurement, the
antenna should be pointed towards each of the four corners of the

office.
-86 dBm -60 dBm
-86 dBm -70 dBm
Stage 1: Using the directional antenna, four maasurements =
are made from the center of the rectangular search area,
pointing the antenna towards each of the four corners

erb59s.eps

Note

Each time you point the antenna in a new direction or
when you move to a new location, click the [Reset
Signal Averaging] button on the Device Finder. Then,
wait for the confidence level to settle to a small value (at
most +5 dBm) before recording the signal strength.

: Control Panel a x

LRESEt Signal Averaging ]

Select this each [ Clear all Measurements ]

time you move to

a new location to [ Stop Finding ]
reset signal averaging.

erb54s.eps
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This is the confidence level — i -100 dB i
once at a new location (and b ax Strength [dBm];

after resetting the signal S0+0
averaging). \
120 dBm

Wait until it is a small value
before recording a measurement.
It should be less than + 5 dBm.
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For the corner that has the highest signal strength, map out a
rectangular sub-search area comprising one quarter of the total office
space. You only need to make measurements from one spot,
pointing the antenna towards four different directions.

-54 dBm -60 dBm ==

Stage 2: Repeat the same process — using the directional antenna to search in four
directions, from the center of the search area — only now using one-quarter of the original
search area. The quadrant to use is the one that had the highest power measurement in the
previous stage. (Here, the size of the quadrant is exaggerated for purposes of illustration.)

erb60s.eps
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3. Repeat, making measurements in the quadrant with the highest
power reading.

|
|
g
|
|
]
Bl
|

Stages 3 through N: Repeat the process again, once more using
one quarter of the original search area, with one vertex at the
location of the highest previous measurement.
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You will learn from experience whether the final measurements are
best made by a continued process of rectangular bisection or whether
the final measurements should be made on a systematic grid of a
local area.

Final Stage: When you have reached a sufficiently localized search area, it may prove
effective to simply search on a grid basis—that is, repeated measurements at relatively
brief intervals—until the strongest readings have clearly identified the location of the
interfering device.
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Detecting Narrowband Devices

Interfering devices fall into two RF categories: narrowband and wideband.
By the very nature of wideband transmissions, the signal strength from a
wideband device—as measured at any one location—tends to be consistent.
(If the directional antenna is in use, the signal strength from a wideband
device will tend to be consistent, at a given measurement location, and for a
given direction in which you point the antenna.)

By contrast, narrowband devices have certain signal peculiarities. Small
changes in the physical environment—changes which have nothing to do
with the device emitting the signal—can cause large fluctuations in the
signal strength. For example, the simple movement of people or furniture
can change the way a narrowband signal is reflected throughout the
enterprise space, resulting in changes in signal strength as measured from
some distance away.

The signal from narrowband devices can vary significantly over the space of
just a few inches. As a result, there are some simple antenna tricks to use
when searching for such devices:

e Omni-directional antenna: If you are using the omni-directional
antenna (including the built-in antenna on the AnalyzeAir Spectrum
PC Card Sensor), it can be helpful to slowly, physically sweep the
AnalyzeAir PC in an arc along several inches, until you achieve the
maximum signal strength.

e Directional antenna: If you are using the directional antenna, a
similar trick applies. With the PC resting in place (such as on a cart),
and with the antenna pointed in a desired direction, you can slowly
sweep the antenna along an arc of roughly 30 degrees to 45 degrees,
centered on the primary direction of interest, until you achieve the
maximum signal strength.

rd
7~
re

: ”
|

Solid line indicates main direction of interest for
signal measurement. Dotted lines indicate
approximately 45 degree arc of measurement
through which the antenna should be moved.
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Local Settings

There are a number of settings you can change to determine how
AnalyzeAir operates and presents data. The available settings are for:

e Sensors and Antennas — Determine which Sensor AnalyzeAir uses to
obtain data. For the internal Spectrum PC Card Sensor, you can also
indicate the type of antenna in use.

e Console Settings — Changes the date formats that are seen on the
screen.

¢ Band and Channel Settings — Determine which 802.11 channels and
how wide a bandwidth will be monitored by AnalyzeAir.

e Alert Settings — Enable or disable security and performance alerts for
an interferer type or category.

e SNMP Option — Configures the trap filters and threshold levels that
trigger AnalyzeAir to send an SNMP trap when it detects an
interfering device. The Settings - SNMP screen is used to configure
the trap filters and threshold levels that trigger the sending of an
SNMP trap.

Sensors and Antennas
To select which antenna is used by AnalyzeAir:

1. Select Tools 2 Settings...

By default, the Sensor Setup panel is displayed. If it is not, click the
[Sensors and Antennas] button.

Settings - Sensors and Antennas

Sensors and
Antennas

|
|
|
I Spectrum PC Card Sensor Sekup
|
|
|
|
|

() Internal Spectrum PC Card Antenna

(O External Spectrum PC Card Anterna

B02 .11 Dnutomatically start sensor connection with
these settings when software is launched.

Y na Some Spectrum PC Card sensors may seleck external ws, internal
HE antenna automatically in lieu of above setting.

Band and Channel

Settings

a

Alert Settings

SNMP
SMMP Option l OK ] [ Cancel ]

Sensors and Antennas Settings

eyb101s.tif
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2. Select the desired sensor/antenna combination. Choose one of the
following:

¢ Internal Spectrum PC Card Antenna — Tells AnalyzeAir to use the
internal Spectrum PC Card antenna.

e External Spectrum PC Card Antenna — Tells AnalyzeAir to use the
external Spectrum PC Card antenna.

3. Optionally, select the Automatically start sensor connection with
these settings when software is launched check box.

If you select this option, AnalyzeAir uses these settings each time the
program starts. If left unchecked, AnalyzeAir presents a dialog box
each time the program starts, asking you which Sensor to use.

4. Do one of the following:

e Click [OK] to confirm your changes and close the dialog box.

OR
e C(lick [Apply] to apply your changes while leaving the dialog box
open for further work.

Console Settings
These settings enable you to fine-tune how AnalyzeAir displays data.
1. Select Tools - Settings...

2. From the tool bar on the left, select Console Settings.

Settings - Console

“. Spectrum Yiew Configuration For Playvback
e !

(%) Load From Capture Fil () Keep Current

Sensors and
Antennas

Dake Formats Used Throughout the Application

Thu Apr 05 16:00:00 Nl

Eum

Instant Replay

ERG2 [¥]Enable Instart Replay of the last | 1 /2 minutes

L |

e —— Default AP Category

Fettings () In-Metwork, ) Unknown
AN
N Plot's Background Color
White
Alert Settings © Black o
SNMP
SMMP Cption [ QK ] [ Cancel

eyb106s.tif

Console Settings
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3. You can change the following settings:

e Spectrum View Configuration for Playback — Select whether
during playback you will view the Spectrum View saved in the
capture file or use the Spectrum view currently in use.

¢ Date Formats Used Throughout the Application — Select from the
drop-down list box. This format is used wherever the date appears
throughout the application.

¢ Instant Replay - Enable the Instant Replay feature by checking
the box and selecting the number of minutes that you want
available for use as an instant replay. Values range from 1 to 60
minutes.

e Default AP Category — Set the default AP category to In-Network
(trusted) or Unknown (potentially rogue). By default, newly
discovered APs are marked as “In-Network".

¢ Plot’s Background Color - Select a radio button to set the
background color for Spectrum Expert plots to Black or White.

4. Do one of the following:
e Click [OK] to confirm your changes and close the dialog box.

e Click [Apply] to apply your changes and leave the dialog box
open for further work.

Band and Channel Settings

On this screen, you can configure the bands and channels that AnalyzeAir
will monitor and report on. You can select band and channel settings by
Regulatory Domain or define the bands and channels individually by
selecting the User Defined option.

Note

Of the channels you select, AnalyzeAir only monitors those
that also fall within the bands you select.

Regulatory Domain Options
1. Select Tools - Settings...

2. From the tool bar on the left, select Band and Channel Settings.
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Settings - Bands and Channels
Regulatory Domain
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Channel Settings

3. In the Regulatory Domain drop-down list, select one of the following
regulatory domains to monitor:

Note

The controls in the Monitored Bands and Channels
control pane also display the bands and channels that
will be monitored when a regulatory domain is chosen.

e Americas/Australia, EMEA/Asia/Pacific, Japan, or All Wi-Fi
Channels.

It is also possible to select the Wi-Fi standard to be covered
(802.11 a, 802.11 b/g, or both) using the checkboxes. The single
regulatory domain choice will apply to both Wi-Fi standards.

e User Defined
When you select User Defined, the individual band and
channel check boxes are enabled so you can individually select

the one or more bands and one or more corresponding
channels to monitor.
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4. Do one of the following:

e Click [OK] to confirm your changes and close the dialog box.

OR

e Click [Apply] to apply your changes and leave the dialog box open
for further work.

Note

Regulatory domains are subject to change without
notice and may vary based on where the devices are
being used (indoors or outdoors) or the protocol data
rate and associated keying or modulation techniques.

Monitoring

The Spectrum PC Card Sensor is capable of monitoring up to 1 GHz of RF
bandwidth at a time. In practice, however, monitoring this much of the
spectrum can result in some performance issues for AnalyzeAir. Moreover,
for most practical applications, it is rarely necessary to monitor that much of
the spectrum at one time.

The Band and Channel settings enable you to determine how much
bandwidth is actually monitored by the Spectrum PC Card Sensor.
Monitoring only the bandwidth you need to monitor—rather than trying to
have the Sensor scan its full potential range—results in more effective
system performance.

¢ If you change the settings for monitored bands and channels,
AnalyzeAir automatically restarts, clearing all internal buffers. The
display does not close down, but you lose any data currently shown
on the Spectrum Plots, Channel Summary, Devices View, etc.

¢ The bands you define here determine which bands are available for
selection on the spectrum plots. See “Frequency and Bandwidth to
Monitor” on page 63 for more information.

e If you select two bands that are adjacent or overlap (for example,
5.47 to 5.725 GHz and 5.725 to 5.850 GHz), AnalyzeAir automatically
consolidates the two bands into one band.

You can select one or more bands. Selecting all or most of the bands shown
may result in reduced performance or data quality, so use only those bands
that are essential for your current monitoring and testing needs.
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Alert Settings

The Settings - Alert screen is used to configure performance and security
alerts.

To access alert settings:
1. Select Tools 2 Settings...
2. Select the Alert Settings icon on the left side of the Settings dialog.

Settings - ALERT
& '.a. Active Devices | Spectrum | Channel Surnmary
e )
Sensors and [JEnable Performance Alerts &
Antennas
Critical Warning
Interferer Duky Cycle (%) 50 75
[CJEnable Security Alerts 8¢
) ERCZ Category )
: g:; [ Bluetaokh
" ?‘“E [] cordless Phones
Band and Channel [ Microwaes Ovens
Settings [ &oz.11 FH
I |:| Genetic - Fixed-Frequency
'E : Jarnmers
] ! |:| Generic - Frequency-Hopped
I |:| Genetic - Conkinuous
| __ilert Settings | [ analog video
[] wi-Fi APs (In-Metwork) v
— Set To Default
SNMP [ setToveraut |
SHMP Option [ oK ] [ Cancel ]

eyb109s.tif

Alert Settings

The Settings - ALERT screen contains three tabs:

e Active Devices —used to enable or disable interferer duty cycle
performance alerts and security alerts for interferer types or
categories. Security alerts can be enabled/disabled for one, several, or
all interferer categories.

Note
Alerts appear in the Active Devices pane.

e Spectrum -used to enable or disable Spectrum alerts

e Channel Summary —used to enable or disable alerts for channel
devices being displayed in the Channel Summary view.
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To enable alerts for active devices:
1. Select the Active Devices tab.
Check Enable Performance Alerts.
Check Alert only if In-Network Wi-Fi AP exists.
Check Enable Security Alerts.

i A W N

In the Category pane, check one or multiple device categories for
performance monitoring and alerts.

Note
The default settings are Jammers and Wi-Fi Ad Hocs boxes
checked.
6. Select [Apply] or [OK].
Notes

If the interferer duty cycle is greater than 50% (default
critical threshold value), the device displays in Red.

If the total duty cycle is greater than 25% (default warning
threshold value), but less than 50%, the device displays in
Yellow.

To enable security alerts for Spectrum:
1. Select the Spectrum tab.
2. Check the Enable Spectrum Alerts check box.
3. Select [Apply] or [OK].

To enable alerts for Channel Summary:
1. Select the Channel Summary tab.
2. Check the Enable Channel Summary Alerts check box.

3. Check the Alert only if In-Network Wi-Fi AP exists check box if you
want this condition to be met a Channel Summary alert is generated.

4. Select [Apply] or [OK].
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SNMP Option Settings

AnalyzeAir can send SNMP traps when it detects interfering devices. MIB
files are installed with AnalyzeAir (in the MIB folder of the installation
directory) and are used by the trap receiver.

You can configure and enable trap filters and set threshold levels that
trigger the sending of an SNMP trap for detected interferers to a designated
IP address on the Settings - SNMP screen. The screen consists of the
following areas:

IP Address

e |IP Address
e Trap Filters
e Modifying Trap Filters Default Settings

e Trap Filter Information Content

IP Address identifies the IP address that you want to send SNMP traps for
detected interferers to. Select the checkbox and then supply the desired IP
address.

Trap Filters

Trap Filters lists three selectable channel criteria an interferer must meet to
trigger AnalyzeAir to send a trap:

Active Channel Filter: is there an active In-Network Wi-Fi AP on one
of the affected channels? The default state is ENABLED.

Interference Channel Utilization Filter: does an affected channel have
an interferer utilizing more than the user-specified channel
utilization percentage? The default state is ENABLED, and the default
threshold value is 10 %.

Interference Power Filter: does an affected channel have a
cumulative power (of all interference devices) that is within or
exceeding the user-specified power level (in dBm)? The default state
is ENABLED. The default value for the within range is 16 dB and the
exceeding default value is — 70 dBm.
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Modifying Trap Filters Default Settings

All threshold values can be edited to reflect differing criteria. To modify the
SNMP Traps and trap filter settings, do the following:

1.

For each trap criteria that you want to edit, click the adjacent box
and then change the current value.

2. Select <Apply>.
3. Select <OK>.

Trap Filter Information Content
The trap includes the following information:

Device Uptime
MAC Address and Power level of the top five APs
Unique Instance ID of the device

Type of Device (humeric code)

Filter Parameters (when the filter is enabled)

Channel Number, Interference Utilization

AP MAC address, AP power, Interference Power

Device Parameters (note that not all devices have all of the following
parameters):

@)

0O O O O O O O o

e}

Center Frequency
Bandwidth

Power in dBm
Duty Cycle
Channels affected
Network address
Pulses per second
Pulse duration

Modulation type: tone, video, AM, FM, QAM, OFDM, chirp
(numeric code)

PLL offset
Frequency Deviation
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Period
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Set SNMP Traps
To set SNMP traps, d

Symbol rate
Bits per symbol

interval

o average power

Transmit type

o the following:

1. Select Tools 2 Settings...
2. From the tool bar on the left side of the dialog box, select the SNMP

Option.

Settings - SNMP

Sensors and
Antennas

Band and Channel
Settings

&

Alert Settings

SNMP

SNMP Option

[]send SMMP Traps for Detected Interferers to IP Address:

Trap Filkers

In order to generate a trap, the interferer must meet all of the checked
criteria for how it affects a channel:

[ There is an active WiFi AP on at least one of the affected channels.

An affected channel has some interferer operating at more than
the Following % channel utilizakion,

10 Yo

An affected channel has interference power

within | 16 dB of the WiFi AP power on the chanmel, or

greater than
=70 dBm

o) (oo

SNMP Option Settings
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3. Select the Send SNMP Traps for Detected Interferers to IP Address:
checkbox and supply an IP address in the address field.

4. Inthe Trap Fi

Iters section, select the desired criteria.

5. Select <Apply> or <OK>.
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Capture Current Display

The Capture Current Display command creates and saves an image of the
information displayed in the main window of AnalyzeAir. Information can
be recorded, for example, at various locations (as when performing a site
survey) or at different times. The images produced by this feature can be
easily emailed, and can be viewed at any time using any favorite image
display software for Bitmaps or JPEG images.

To capture the current Console display:
1. Select Tools > Capture Current Display... or press <Ctrl+S>.

The application creates a snapshot of the information visible within
the main application window.

2. In the Save As... dialog box, select the file location and then enter a
File Name (or use the default file name).

3. Select the file format from the Save As Type list box.

Image file formats that are available include Bitmap (for larger file
size with maximum clarity) and JPEG (for smaller file size; useful for
email and space savings).

4. Click [Ssavel.

Example: If the Channel Summary tab is currently selected, the image
contains the current channel information that is displayed on-screen. If the
current active view is one of the Spectrum tabs, the image captures the plot
data that is visible on the screen. The Active Devices Tree and Control Panel
are also preserved in the image, assuming they are currently displayed.

Tips on Image Capture

If a view has scroll bars, be sure to scroll so that the information you want to
capture is displayed on screen.

For best results, make sure that the application window is fully visible on the
screen. If the application is partially visible, the captured image will contain
only the area of the main application window that was visible.

Tips on Image File Naming

108

For future reference, it may be helpful to include the location and date as
part of the image file name or to organize images into a labeled folder with
this type of information.

This feature automatically suggests a file name including a date/time stamp.
If you customize the text appearing before the date/time stamp, AnalyzeAir
will preserve this customization and automatically apply it to snapshots
created later during the same console session.
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AnalyzeAir and Your Network Operations

The preceding sections of this manual have been devoted to an overview of
AnalyzeAir, and then a detailed discussion of how to use specific features
and operational modes. This section explains how to put AnalyzeAir to work
in the real world of network planning, maintenance, and troubleshooting.

A key, general principle to keep in mind is that the RF environment, by its
very nature, is highly dynamic and unpredictable. The environment varies
over time as both RF sources and RF reflectors move about or change in their
activity. (And keep in mind that an “RF reflector” can be virtually anything
at all, obviously including metallic objects, but also other types of objects,
and even people.) Further, some RF sources, such as directional antennas,
have a strong RF impact in limited spaces or directions. As discussed later,
the variability of the RF environment must be taken into account when
putting AnalyzeAir to work.

Site Survey

A site survey is a series of RF measurements conducted not only prior to
network deployment, but possibly even prior to deciding what type of
network equipment to purchase. The site survey is intended to provide a
general picture of the RF environment, and particularly those aspects of the
RF environment which may influence purchase decisions. The information
gained in a site survey will also contribute to network planning (covered in
the next subsection).

The primary goal of the site survey is to determine which channels/bands are
acceptable for network deployment. The survey can also suggest the
number of network devices, such as APs, that may need to be purchased and
deployed. This is particularly crucial for those networks where you have a
choice of the type of network equipment to purchase (802.11a, b, or g).

The Physical Movement of the PC

The site survey entails physically moving your AnalyzeAir PC or OptiView
Series Il or Series Il Integrated Network Analyzer throughout the network
space, monitoring changes in the readings as you go. You can carry the PC
or OptiView Series Il or Series lll Integrated Network Analyzer, but typically
you place it on a cart and wheel the cart about. In offices, you will want to
at least walk around the perimeter of each office, and perhaps up and down
and side-to-side through the center of each office. In a hallway or corridor,
it may be sufficient to roll the PC or OptiView Series Il or Series Il Integrated
Network Analyzer down the center of the hallway. In a large open space,
you may want to walk up and down in lanes, much as if you were “mowing”
the carpeting or floor tiles with the PC or the OptiView Series Il or Series IlI
Integrated Network Analyzer.

We can't tell you the exact physical “granularity” of the survey — that is, we
can't say if you should walk up and down your office in lanes spaced five
feet apart or fifteen feet apart. Partly it depends on the size of the site you
are covering — you are likely to have the time to follow a finer, more closely
spaced path in a 5,000 square foot office than in a 100,000 square foot
warehouse. We can say that the more fine-grained your site survey, the
more accurate the information you will obtain. Certainly, just taking
measurements in four corners of a large space, and at the center of that
same space, is generally not sufficient.
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Note that site surveys can be done not only for indoor areas, but also for
outdoor deployments of network equipment. For example, it is now
common to set up network backhaul links on the rooftops of buildings. A
site survey done on the rooftop can detect all kinds of interference activity
from neighboring transmitters. Again, the more rooftop space that is
covered in the survey, the clearer and more accurate will be the picture of RF
activity.

AnalyzeAir Survey Data

110

Typically, during the survey you will want to look at the AnalyzeAir Channel
Summary, the Devices View, and two or three of the spectrum plots: the
Real Time FFT plot, the FFT Duty Cycle plot, and very likely the Swept
Spectrogram plot.

¢ The Channel Summary indicates which channels are showing the
most RF activity and gives you a rough indication of how much of
that activity is due to interferers and how much is due to other
network devices.

o If the activity is due to interferers—and if those devices are in
your space and under your control—you may be able to
remove or shield some of the interfering devices.

o We are assuming that you have not deployed your own
network yet. So, if you are picking up activity from other
network devices, these are likely to be devices in neighboring
networks. If you do not own these networks (for example,
they belong to a company in an adjoining office), you may not
be able to do anything to prevent this interference. In this
case, you may need to plan your own network to use other
channels or bands which are not in use by that network.

¢ The Devices View shows you specifically which devices are causing RF
activity. The information includes the channels on which these
devices are operating. Based on this specific information, you can
start to determine whether you can mitigate or remove these devices
or whether you need to plan your network operations to work
around this device activity. For example, if the devices cannot be
removed, shielded, or turned off, you may need to operate your
network on channels that are not affected by those devices.
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The plots—Real Time FFT, FFT Duty Cycle, and Swept Spectrogram—
can be used to obtain a more fine-grained view of spectrum activity.
Note that the Swept Spectrogram can be used to view either RF
power or RF duty cycle. The combined time and frequency view
offered by the Swept Spectrogram is also especially useful for
viewing variation or stability in spectrum activity over the time
interval of a few minutes.

o These plots can be particularly useful for evaluating borderline
channels in the Channel Summary or viewing the number of
devices seen on a channel in the Devices View.

Both the Channel Summary and Devices View present a
summary of RF activity seen over some extended period of
time. It may be, however, that on some particular channel(s),
the RF activity is in fact bursty in nature, i.e., it is characterized
by sporadic pulses of RF activity. Because network activity
itself is also bursty, such a channel may in fact acceptable for
network purposes — RF activity from non-network devices will
only occasionally occur at the same time as network RF activity.

In other words, looking at the spectrum plots can help you
determine if the interference is constant or intermittent and if
the interference on a given channel is, in fact, tolerable from a
network standpoint.

o The spectrum plots are also useful for detecting interference
which is created by devices that are completely unclassified by
AnalyzeAir. While these devices will not show up in the
Devices View and will not impact the measurements in the
Channel Summary, you will see their RF activity on the
spectrum plots.

There are at least two conclusions you can generally draw from the data
obtained:

You can determine which RF channels are your cleanest. This may
determine which types of network equipment you buy, or at least
which bands or channels you set your network equipment to use. For
example, if you find that the entire 5 GHz band is being swamped by
nearby RF activity, you can plan your network purchases and
configuration to operate in the 2.4 GHz band.

You may find that even your best channels or bands are only
relatively clean; there may still be substantial, unpreventable RF
activity. This will generally indicate that you will need to purchase
more network devices to obtain adequate network performance and
coverage.

Of course, “more network devices” is a relative term. You would
need to make some kind of baseline decision for your particular
network technology—for example, how many APs would it take to
provide adequate coverage for your Wi-Fi network, in a clean RF
environment?—based on the particular specifications of the network
equipment. Then, if the available channels are fairly congested with
RF activity, you may need to scale that number by, say, 50% or 100%,
to ensure reliable and speedy network performance.
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Rather than purchasing more network devices, another option—if
significant RF interference will be an ongoing issue—is to instead
purchase more powerful network backbone devices, which can
overcome the local interference with a stronger signal.

Note, however, that boosting, say, the power of your Wi-Fi APs, does
not boost the power of the Wi-Fi stations which may be in use. (Your
network environment may be a public one, where you do not control
the design or broadcast power of all the stations that may be in use.)
In this case, a higher density of backbone devices (e.g., APs) may be
the only effective solution.

Additional Notes on Site Survey and the Spectrum Plots

This section provides additional information about conducting a site survey
and viewing the Spectrum plots.

Monitoring Multiple Bands on Spectrum Plots

A spectrum plot can only monitor one band at a time. However, on a single
Spectrum tab, you can open more than one instance of the same type of
plot (such as the Real Time FFT). By setting each instance to monitor a
different band, you can monitor at the same time all, or almost all, of the
bands of interest.

Real Time vs. Software-Based Plots

The reader may note that we have not recommended the Power vs.
Frequency or Power vs. Time plots for site survey purposes. These two plots
require extensive software analysis on your AnalyzeAir PC, and are intended
mainly for analyzing specific RF issues (typically, RF problems related to some
unknown device).

The Real Time FFT, FFT Duty Cycle, and Swept Spectrogram plots offer data
directly from the Spectrum PC Card Sensor hardware, and are designed to
give a better, more accurate picture of overall RF activity in a particular
band. The band-inclusive view is most applicable for site survey purposes.

Conducting the Site Survey

We indicated earlier that AnalyzeAir needs to be wheeled about the
anticipated network environment and that you will benefit from using
multiple AnalyzeAir modes—Devices View, Channel Summary, and several
spectrum plots—to conduct an effective site survey. So you need to wheel
the PC about, while switching between viewing modes, in order to get the
job done.

In addition, a physical map of your site, where you can record notes of key
readings, may prove helpful. There is no mandatory method of doing the
site survey, but what follows is a possible approach.

1. Pick a location, typically one corner of the anticipated network space,
in which to start the survey. Look at both the Devices View and the
Channel Summary to see which channels are causing the most activity
and which devices are responsible for that activity. Make note of this
information on your map of the network space.
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Switch to the Spectrum View mode and set up the plots you want to
view. Since there are two Spectrum tabs, you may want to use each
tab for a different kind of plot. For example, on one tab you can set
up multiple instances of the Real Time FFT, with each instance set for
a different band. On the other tab, you might establish multiple
instances of the Swept Spectrogram (again, picking a different band
for each instance) with the Trace Type set to Duty Cycle.

Wheel the AnalyzeAir PC through the anticipated network
environment. As you move, keep your eye on the spectrum plots—
Real Time FFT or Duty Cycle, as you prefer—perhaps pausing
occasionally to switch from one Spectrum tab to the other.

View all the bands you have set to display on the plots. However,
mentally, you probably want to keep an eye on those bands which
encompassed both the most active and least active channels seen on
the Devices View and the Channel Summary. The goal is to see if this
activity remains fairly consistent throughout the network space, or
varies significantly.

Any time you see a significant change in the spectrum plots—either a
spike in RF activity at some frequency, or a notable drop-off—you can
switch back to Channel Summary or Devices View. The Channel
Summary will likely confirm what you’ve seen on the plots, namely,
that there is a notable increase or decrease in RF activity on particular
channels. The Devices View, of course, will help you identify the
particular cause(s) of that activity.

Switch back to the spectrum plots, and continue your walk through
the network space.

Again, at appropriate points, stop and make notes on your map of
the network space.

There are several possible variations on this procedure.

In terms of how you set up your display during the survey, another
option is to put two Real Time FFT plots and two Duty Cycle plots on
the same tab, covering two bands. Then, put two more Real Time FFT
plots and two more Duty Cycle plots on the other tab, measuring two
other bands. (And—not to confuse the reader—you always have the
option of using the Swept Spectrogram, and setting it to display
either duty cycle or RF power.)

You could make an entire sweep through the network environment
looking only at the Channel Summary; then another sweep, along
the same path, with the spectrum plots on display. After determining
those locations with the most RF activity, you may return to those
specific locations and use the Devices View to ascertain the particular
RF sources involved.

If you note a particularly high level of RF activity at some point, but
the source is not obvious, the Device Finder may help you track down
the source. See “Device Finder” on page 87.
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Save the RF Map

We recommend that you save the RF map you create in the course of the site
survey. It will come in handy later, both for initial network device
deployment, and for charting any changes in your RF environment over
time.

Drawing Conclusions

At the conclusion of this process—and with your marked up network map in
hand—you should have a very clear picture of which frequencies are
relatively clear, and which frequencies are relatively crowded with RF
activity, throughout your network space. Ideally, it will be immediately clear
which channels or bands you wish to use for your network deployment.

Conceivably, you may find that certain bands would be best to use at some
locations in your network environment, while other bands would be better
to use elsewhere. In the worst case, these bands may be hardware
incompatible (for example, if want to use 802.11b/g in one part of your
network and 802.11a in another part). In this case, part of your network
planning may entail removing or shielding some current sources of RF
activity, to free up a particular band in a particular location.

As indicated earlier, the general level of network activity will also help you
determine the number of network backbone devices (for example, APs) that
you need.

Antenna Options

During the initial phase of a site survey, you will want to use the standard
omni-directional antenna, so that at each location you can pick up RF activity
from all possible sources in the vicinity.

In some cases, you may find RF activity that is highly localized, without the
source being apparent. (This can happen, for example, if there is a
directional broadcast antenna at some distance. You will only pick up a
signal when you happen to cross the path of the antenna beam.) At these
locations, the directional antenna can be used to help determine the exact
direction of the source of RF activity. See “Using the Directional Antenna”
on page 23 for more information.

114



Wi-Fi Spectrum Analyzer
AnalyzeAir and Your Network Operations

Network Layout

After you purchase your network backbone equipment, AnalyzeAir can
support a dynamic, real-time network layout process that results in near-
optimum placement of APs. You will rely upon the Devices View, the
Channel Summary, and the spectrum plots (Real Time FFT, Duty Cycle,
and/or Swept Spectrogram) to perform this task.

Placing the First AP

1.

To start the process of deploying devices, select a location for
placement of your initial AP. Of course, you'll need to select a
location that is sufficiently close to an Ethernet connection for your
wired LAN.

In addition, you'll want to select a location which you had
determined, in the course of your site survey, to have low RF
interference. (Again, we recommend that you save the RF map that
you created during your RF site survey.)

At the selected location, you'll use AnalyzeAir to double-check that
RF activity remains at acceptably low levels in the channel you intend
to use. (Depending on your overall environment, the RF activity may
or may not vary substantially over a relatively short time frame. For
example, a neighboring office may have rearranged or reconfigured
their WLAN in ways that will affect your network deployment.)

As with the site survey, you can use the Channel Summary and
spectrum plots to check the overall level of RF activity at the selected
location. The Devices View can tell you about any specific devices
that are now causing interference, and which can possibly be
removed or shielded. If there is new, and uncontrollable, RF
interference which had not been detected during the site survey, you
may need to select another location for initial AP deployment.

You have selected a location for the initial AP, set it in place, and
probably wired it into the LAN. Before powering up the AP, you
should set one of the Real Time FFT plots to monitor the channel
which will be used by the AP. When you turn on the AP, you should
see an immediate and dramatic gain in RF power in that channel.
This tells you that the AP is broadcasting RF on the appropriate
channel.

You will now turn to the Devices View. AnalyzeAir should quickly
detect and classify the AP so that it is shown in Devices View. Of the
most interest is the Signal Strength field. Normally, the signal
strength near the AP should be well above -70 dBm.

Note

The expected signal strength when you are near the
device varies depending on the type of network you are
deploying. Similarly, depending on the network
technology you are implementing, the power level that
is too low for reliable operations (discussed later) also
varies. The values described here (in the range of -70
dBm to - 80 dBm) are appropriate for Wi-Fi network APs.
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Placing the Second AP

1.

With AnalyzeAir once again in hand or on a rolling cart, you now want
to move in some direction away from the AP you have just placed. The
direction you choose will depend on your general plan of network
deployment, as well as on the RF map created during the site survey.

For simplicity of description here, we’ll assume you are laying out your
network in some relatively, wide open space, such as a warehouse or
airport terminal. Naturally, if you are in a more constrained space, such
as an office, your movements will probably entail leaving one room and
entering an adjacent room, or possibly walking down a hallway outside
the room.

In general, your goal for placing the next AP is to aim for location which
is again structurally convenient—for example, you may want to remain
close to a wall, so the AP is relatively out of the way of other activity and
movement—and is close to another Ethernet connection.

As you move AnalyzeAir in the general desired direction, keep an eye on
the device signal strength on the Devices View. When the signal
strength falls to around -70 to -80 dBm, this indicates that the first AP
can no longer reliably communicate with network devices at your current
location.

Choosing the higher threshold value, -70 dBm, will provide greater
network reliability, at the price of placing APs closer together. That will
mean purchasing more APs. The lower threshold, -80 dBm, may result in
somewhat less network reliability and/or data rates, but also involves
deploying fewer APs.

At this point, where the AP signal strength has dropped to -70 dBm or
-80 dBm, you will probably want to deploy the next AP. You should set
the new AP to a channel substantially apart from the channel used for
the first AP. (For example, you might vary your APs between channels 2,
5,and 8,0or 1,6, and 11.)

However, before “committing” your AP to this new location, you should
use AnalyzeAir to double-check a few things:

e Using the Channel Summary, make sure that the channel you have in
mind is reasonably free of local interference.

e Check the Spectrum plots to ensure that the location is fairly free
from excessive RF activity of all kinds.

As usual, if you encounter undesirable RF activity at the location of
interest, you will need to take steps to mitigate the interference, deploy
a more powerful AP, or choose another location.
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5. Set the second AP in place at the new location, and wire it into the LAN.
Set one of the Real Time FFT plots to monitor the channel which will be
used by the AP. When you turn on the AP, you should see an immediate
and dramatic gain in RF power in that channel. This tells you that the AP
is broadcasting RF on the appropriate channel.

6. Again turn to the Devices View. AnalyzeAir should quickly detect and
classify the AP, so that it is shown in Devices View.

Placing Successive APs

From here, you will continue the deployment process in a similar manner,
repeating the previous steps 1 through 6. You may very likely need to go
back to the first AP, and head off in a new direction—at right angles to your
first path, or directly opposite—to place the third AP. Depending where
each AP is placed in your overall network environment, you may need to
place anywhere from one to four APs that are adjacent to it at some
distance.

e In each case, however, as you travel away from an AP, an indication
that the AP no longer provides adequate signal coverage is when the
AP’s signal falls to around -70 to -80 dBm.

e Also, be sure that adjacent APs are not broadcasting on the same
channel.

After-Deployment Site Survey

After deploying all your APs, you will want to conduct another site survey.
This time, you do not need to cover all the ground, as with the initial survey.
However, you want to focus on areas which, just by reviewing your AP
layout, you can see are relatively far from any one AP.

In those areas, you will want to move AnalyzeAir around a bit, and use the
Devices View to ensure that at least one AP is clearly detectable, preferably,
giving a Signal Strength greater than -70 dBm. This ensures that any device
in the area will be able to communicate with at least one AP.

In addition, you may want to activate some of the known interferer devices
that operate within or near the perimeter of your network—cordless
phones, microwave ovens, etc. You can use both the spectrum plots and the
Channel Summary to see if any of these devices are swamping the RF
environment with so much energy that they are likely to impede RF
communications. If that is the case, you can deploy additional APs, or more
powerful APs, to compensate for the interference.
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Long-Term Trend Analysis

Your network’s RF environment can change over time, requiring adaptive
changes in your network deployment. Quite typically, these changes will be
for the worse—more RF activity, and more interference—as your
organization grows, and the number of wireless devices (both network
related, and interferers), increases as well. You may need to deploy more
network backbone devices or more powerful devices, to compensate for the
change.

Ideally, you would like to know about emerging RF trends before they
impact your network. AnalyzeAir can be used for systematic monitoring and
recording of the RF environment, enabling you to observe emerging trends.
The key tools here are: the Devices View, the Channel Summary, the
spectrum charts, the screen capture feature, and the record/playback
feature.

Trend Analysis Procedure

The general strategy is to pick a number of key locations in your network
environment, and record spectrum data at those locations at regular
intervals. How frequent those intervals should be depends on your own
assessment of the pace of change in your network environment. At a small
but rapidly growing startup company, you may want to make measurements
as often as every two weeks. At a much larger, established organization,
with a more gradual growth curve in staff and activity, once every two
months might be sufficient.

You can record data both in the form of screen captures of relevant data
(see “Capture Current Display” on page 108) and in the form of Spectrum
Capture files, which capture real-time data for later playback (see
“Recording and Playback” on page 38). For screen shots, you can maintain a
notebook where you store printouts of the captured screens. The screen
images should be annotated by both date and location. Flipping through
the pages in date order (or laying them out on a table for side-by-side
comparison) will make it easy to see significant trends in network and RF
activity. Similarly, you can view successive Spectrum capture files, one after
another, to discern any important increases in RF activity.

Type of Data to Record
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We recommend the following types of data as being most useful for long-
term trend analysis.

e Devices View — The particular RF devices in use at any given moment
can vary widely during the course of a day. However, you can set the
Devices View to display all devices that have been used during an
extended period of time during the day, such as the last four hours or
the last twelve hours. This will create a broad picture of all the RF
devices in use during a typical day, or large part of a day. If you
capture this data at regular intervals (for example, every few weeks
or every few months), you can see whether there is substantial
growth in device usage.
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You can also see if a particular type of device is being used more and
more, and can make a decision as to whether the type of device in
question is likely to impact network operations.

Channel Summary — This view of the RF spectrum indicates the
amount of activity on each channel. Taking “snapshots” of this
information at regular intervals will help you determine if any
particular channels are become crowded with excess activity. This
may result in you choosing to change the channel assignments for
your network backbone devices.

Note that the Channel Summary is, by its basic design, a snapshot
view of “right now.” Like the use of devices, channel usage can vary
significantly over the course of a day. Therefore, on the days when
you elect to record data for long-term trend analysis, you may want
to capture channel usage at several times during the day. This will
make it easier to determine which channels have consistently high
activity or low activity.

Time-Oriented Charts — The time-oriented spectrum charts—Devices
vs. Time and Channel Utilization vs. Time—are the ideal tool to
ascertain overall RF activity over the course of a single day. By setting
the time interval to 8 hours or 24 hours, you can obtain a global view
of RF activity over the course of a day. (Eight hours is appropriate for
most office environments; while the 24-hour view is appropriate for
environments such as factories, warehouses, and airports which are
the hub of day and night activity.)

Since a single Devices vs. Time chart can display, at most, four
different types of devices, you may want to put two charts on display
at the same time, to capture up to eight different device types.
Similarly, the Channel Utilization vs. Time chart can only display data
for one band. Putting multiple instances of the chart on display
enables you to record data for multiple bands.

The goal is to take screen captures of these charts at regular intervals
in time (for example, every two weeks), noting both the location and
date. After some extended time has passed (typically several
months), placing the charts from different dates side-by-side, in
ascending date order, will clearly indicate significant increases in the
number of devices in use, or the RF duty cycle, or both.

Channel-Oriented Charts — The Devices vs. Channel and Channel
Utilization charts provide more specific information about RF usage.
While they only cover a fixed, short interval of time—they update
approximately every twenty seconds—they provide a clearer
indication of specifically which channels are being impacted by RF
activity. As with the Channel Summary display (discussed earlier), we
recommend that on your “trend analysis days”, you take snapshots of
the channel-oriented charts at several times over the course of the
day. This will help provide a combined time and channel-oriented
view of RF activity.
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Routine Network Monitoring and Troubleshooting

After your network is up and running, AnalyzeAir enables you to monitor
the RF environment on a daily basis, often detecting potential problems
before they become apparent to users. In addition, when users flag
problems, such as network slowdowns or lost connectivity, AnalyzeAir
enables you to quickly pinpoint the source of the problem.

Routine Monitoring

For routine monitoring, we suggest that you set one of the two Spectrum
tabs to display the following plots and charts: Real Time FFT, FFT Duty Cycle,
Swept Spectrogram, and all of the spectrum charts (Active Devices, Channel
Utilization, Channel Utilization vs. Time, Devices vs. Channel/Time).
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AnalyzeAir Set for Routine Network Monitoring

Notice that more than one Devices vs. Time chart is in use (lower right of the
previous figure). This is because each such chart can track a maximum of
four device types. To track more than four devices, you need to put at least
two such charts into use. Similarly, you have the option of using more than
one Real Time FFT plot, or FFT Duty Cycle plot, in order to monitor
additional bands.
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Monitoring Points and Monitoring Rotation

The general procedure for routine monitoring is to pick selected monitoring
points throughout your network environment.

e Throughout the day, move AnalyzeAir from one monitoring location
to another, holding your position at each location for some extended
length of time (say, one hour, or two hours).

e In alarge network environment—depending on how many
AnalyzeAir computers you have and the size of your network support
staff—you may not be able to cover all of your monitoring points in a
single day. Instead, you may have a rotation among monitoring
points that takes, say, a full week to complete, and then starts again,
covering the same points, the following week.

e Vary The Sampling Times - If possible, each set monitoring point on
your route should not always be sampled at the same time of day. As
a very simple example, and supposing you had just five designated
monitoring points (call them A, B, C, D, and E), and exactly one
AnalyzeAir computer, you might employ a rotation similar to the
following:

Table 4. Sample Time Rotation Schedule

Time Monday Tuesday Wednesday Thursday Friday
Period
8 a.m. to A B C D E
10 a.m.
10 a.m. to B C D E A
Noon
Noon to C D E A B
2 p.m.
2 p.m. to D E A B C
4 p.m.
4 p.m. to E A B C D
6 p.m.
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The point is to make sure that each location is monitored at different
times of day because it is possible that certain locations have low
network utilization at one time of day and higher utilization at another
time of day.

Selection of Monitoring Points — You should seek a mix of locations,
some of which are relatively near your network backbone devices
(such as APs) and others that are relatively far from the network
backbone devices.

The goal is both to make sure that monitoring points far removed
from the network backbone have a healthy RF environment so that
they can pick up signals from the backbone and to ensure that the
backbone devices themselves are able to clearly receive signals from
network members.

Variation Analysis — Under “Long-Term Trend Analysis” on page 118,
we discuss capturing screen shots or recording spectrum activity as
tools for long-term trend analysis. Conceivably, you could use this
daily monitoring as the core of that long-term trend analysis.
However, recording and storing data from multiple locations every
single day is likely to result in an overwhelming amount of data. That
is why we recommend that measurements intended for long-term
trend analysis be taken at longer intervals.

What you can do is make spectrum recordings or spectrum screen
shots on a daily basis during the week and then compare the
recordings/screen taken at the same location, but on different days of
the week and at different times. This comparison will quickly reveal
any unexpected, dramatic changes in the RF and network
environment.

You can quickly determine if a particular location has dramatically
increased activity at different times of day.

If you measure the same location, at the same time, at the beginning
of a week, and again at the end of the week, you can immediately
detect any abrupt change in RF activity. This can occur, for example,
if a new RF device (say, a new microwave oven) was installed during
the course of the week, and is now introducing unacceptable levels of
RF interference.
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RF and Device Monitoring
Using the spectrum view configuration described earlier:

Spectrum Charts — The spectrum charts will show you if there is an
excess of RF activity on a given channel, or an excess of devices on a
given channel. You can also see how RF activity and device activity
vary over time.

Spectrum Plots — The Real Time FFT, FFT Duty Cycle, and the Swept
Spectrogram all help you detect “bursty” RF activity, which may or
may not register strongly on the spectrum charts (the charts generally
reflect more sustained trends in RF activity). Bursty RF activity can
cause network transmission and reception problems, even if the
spectrum charts seem to show a relatively clear environment.

Active Devices Chart and Active Devices tree — Together, these two
display elements provide a clear picture of just which types of
devices—network or interferer—are active in the network
environment. The Active Devices tree will also show you if there are
network devices impacting your network, but which are not actually
part of your network (e.g., APs from neighboring Wi-Fi networks).

Troubleshooting

In addition to routine monitoring, there will be times when a network user
notifies you about problems with network performance or connectivity. In
these cases, you will want to take AnalyzeAir to the location(s) where the
problems are being reported and scan the same plots, charts, and the Active
Devices List, as described earlier.

It is possible that the flawed network activity will be intermittent. You can
set AnalyzeAir in place at the location where the troubles are reported, and
set it to record spectrum data over the course of a day for later review. At
the conclusion of monitoring, you can also look at the Devices View, which
presents an historical view of devices that were seen over a period of up to
24 hours.
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Problem Resolution

Once a problem —such as too many devices in use, or excessive interference
on a particular channel—has been detected and the general cause has been
ascertained, the exact nature of the solution will vary depending on the
problem at hand.

In some cases, the cause of the problem is immediately evident. For example,
a new microwave oven has been put into use, and the RF energy leaking
from the microwave can clearly be seen as increasing the duty cycle every
time the microwave is turned on. Try moving or shielding the microwave.
Similarly, the office may just have gone from standard wired phones to
cordless phones, and the new phones are causing the interference.

The solution here may be to change the channel used by the network
backbone devices.

In other cases, it may be that more and more network devices are being put
into use—for example, as more staff is hired, more wireless computers are
used—and a threshold has finally been reached where the existing network
backbone (APs) can no longer handle the traffic. The solution here is to
purchase additional APs or reallocate some APs from locations where
network demand is not as strong.

Device Finder
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In other cases, the general nature of the problem may be apparent, but the
particular cause is not. For example, the plots and charts may clearly show
increased RF activity when some device is coming into use—but the device
itself is not known. (For example, it may be a generic device, and the
network administrator does not recognize what device is actually implicated,
based solely on the generic parameters.)

In this case, the Device Finder feature becomes an essential tool for tracking
down the interfering RF device. See “Device Finder” on page 87 for more
information.
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Key terms used in this manual are defined in the following table.

Table 5. Glossary of Terms

Term

Meaning

Fast Fourier Transform
(FFT)

A Fourier Transforms is a mathematical operation which takes a waveform
(such as RF waves) and determines the magnitude of the different
frequency components (sine waves and cosine waves) that comprise the
wave. The numbers that give the magnitudes of the sine and cosine
waves can be thought of as a kind of RF “fingerprint” which distinctively
identifies the wave. Waves that are very similar to each other can be
matched because the numbers in their Fourier Transforms will be very
similar to each other.

A Fast Fourier Transform is a computational method which enables Fourier
Transforms to be performed very rapidly (on programmable chips, for
instance), with some very minor imprecision.

Spectrum Analysis

Fluke Networks' technology for enabling RF discovery services, and
supporting WLAN performance and interference mitigation services.

Wireless Local Area
Network (WLAN)

A computer network which uses wireless communication, such as 802.11
technology, and central Access Points (APs), to allow computers to
communicate without physical connecting wires.
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Appendix B
Notices and Declarations

Introduction

The products discussed in this manual are covered by several categories of
regulation in a number of countries. Changes or modifications not expressly
approved by the manufacturer could void the user's authority to operate the
equipment in these regions.

FCC Notices

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC rules. These limits are
designed to provide reasonable protection against harmful interference
when the equipment is operated in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and if not installed
and used in accordance with the instruction manual may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation distance between the equipment and the
receiver.

e Connect the equipment into an outlet on a circuit different from that
to which the receiver is connected.

e Consult the dealer or an experienced radio TV technician for help.
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Industry Canada's Interference Causing Equipment Standard for Digital Apparatus
This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la Classe B est conforme a la norme NMB-003 du
Canada.

Declaration of Conformity (Spectrum PC Card Sensor Only)

This equipment has been tested and conforms to the European Council
Directive 89/336/EEC, Standard EN61326-1:1997/A2:2001 relating to
Electromagnetic Compatibility for Laboratory Test EqQuipment.

V1T 205 Westwood Ave
’ Long Branch, N] 07740

eqUIpment 1-877-742-TEST (8378)

Fax: (732) 222-7088
128 .
.N ET salesteam@Tequipment.NET
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